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Chapter 1

Introduction

Basic information regarding Microspot Modeler and technical support details.
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υ Introduction

Thank you for choosing Microspot Modeler, the affordable, easy to use 3D modeling app
tion for the Apple Macintosh® computer. Designed for novices as well as professionals, 
Microspot Modeler provides the tools you need to create realistic 3D models and anima

υ Entering serial number

The first time you run Microspot Modeler you will be asked to enter your serial number

υ Welcome screen

The welcome screen allows new users to register Microspot Modeler. Registering the pr
allows you to receive technical support, as well as upgrade and new product information

• Never register: Allows you to skip registation and starting using the 
Microspot Modeler. The welcome screen will not appear again.

• Register later: Allows you to skip registation and starting using the 
Microspot Modeler. The welcome screen will appear the next time Interior 
is started.

• Register now: Opens your default browser to the Microspot Modeler regi-
sation page. The welcome screen will not appear again.

Note: If you would like to register but press the Never register button, please use the help
item Registration Information. (see Registration Information on page 3-36 for more informa
tion).
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υ Technical Support

You must register your product in order to receive technical support, as well as upgrade
new product information. Registration information is provided in the help menu or please
the contact information below: 

Address: Microspot Limited
Concorde House
10-12 London Road
Maidstone Kent ME16 8QA
England

Phone: 01622-687771; International: + 44-1622-687771
FAX: 01622-690801; International: + 44-1622-690801

Email: support@microspot.co.uk
Web: www.microspot.co.uk
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Chapter 2

Tutorial

A brief introduction to some of Modeler’s features and tools.
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TUTORIAL ONE

υ Introduction

Welcome to Microspot Modeler. This is the first of 4 tutorials that will take you through
range of tools and features that will enable you to model quickly and easily. The first tu
will introduce the working environment as well as helping you get to know the termino
involved with modeling. From there we will introduce more tools and options for mode
enabling you, the user, to specify how your model looks. This process will take you
through from starting a new model, editing and shaping, modeling to scale and set dime
to finally rendering the model or scene for presentation purposes. Tutorial one focuses 
ting used to the modeling window and changing views to make modeling as easy as po
To do this we will model a dining chair.

The second tutorial onwards will use this same chair as a base for us to edit further, an
same time, this will introduce heightened complexity to the model and increase the amo
tools and techniques we will learn. At the end of the fourth tutorial we will have a library
chairs, each more advanced than the last, to use and edit.
2-3
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υ Getting Started

When Microspot Modeler is first opened the screen will appear as shown below. On the
the Tools palette, this is used to select modeling and editing tools. On the far right is th
palette, this palette displays all the information associated with any selected object incl
position, size, rotation and color. This palette is particularly useful when modeling to sp
dimensions. All the values and settings can be edited in the relevant fields of this palette,
you full control over every object. At the bottom of the screen is the Help palette which g
short description of every tool used and an exact coordinate position of the cursor in te
X, Y and Z. See Tools Palette on page 3-4, Info Palette on page 3-17 and The Help Pale
page 3-28 for more details.

The modeling window can be resized to fill the entire screen or made smaller. The mo
window opens to this size for a good reason. The more involved and complex a 
becomes, the more palettes you will need at hand to aid the modeling and orienting aro
scene. For this reason the modeling window is set to this default size of 600 x 480 
enabling the user to position palettes around the outside of the modeling window fo
access.

Stackable Palettes

If all the palettes are open on screen then space to model effectively can become cramp
is why Microspot Modeler has been designed with what is called stackable palettes. Thi
2-4
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space.

When grouping palettes try to pick ones that are similar in terms of their usage and appl
to the model. Below are two of the palettes from the palettes menu. These are Navica
Tripod respectively. Navicam is one of the primary tools used for altering our view (the ca
as it will be referred to) around a scene or model. The Tripod is a very useful tool for look
specific areas of a model or positioning the camera in an exact way or angle. We can s
both these palettes are used for navigating around a scene, and so it seems only logical
them together. This is done by simply picking up one palette by its name tab and drag
onto the name tag of the other one. See Tabbed palettes on page D-4 for further details.

υ The Grid

For this chair there are set dimensions, these will help determine the size and snappin
working grid. The dimensions are given as follows in terms of X, Y, and Z.

• Overall size: 520 x 1100 x 500

• Rear legs: 40 x 1100 x 40

• Seat: 460 x 50 x 500

• Front legs: 40 x 450 x 40

• Back rest: 60 x 420 x 150 (60 mm includes the curvature of the rest).
2-5
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Note: All dimensions shown are in millimeters unless otherwise stated. Make sure you 
metric mode by selecting Metric in the Options menu.

Under the Options menu select Grid Options. This will open the Grid options palette w
will enable the grid to be set up.

The real key to setting up a good grid is establishing a size that will make the modeling p
quicker by making the grid work for the model without having to constantly change its pr
ties. By default the size of each grid square is 1000mm with a snapping distance of 10
The snapping grid distance is the smallest increment that any object can be moved or 
by. By making this a convenient size it enables the easy and accurate moving and res
objects. 

Now consider what the chair will look like from a birds eye view (along the Y axis). The p
that is most prominent is the seat. Its dimensions are given as 460 x 50 x 500. The Y v
50mm is of no importance at this stage. It is important to keep the gird size close to the
mum values of the model. This way it will be easier to see what is being modeled. If the 
too big then the model will appear far too small, the opposite being if the grid is too sm
will not be of any use when trying to model accurately. 

After considering all these factors the grid size for this chair will be 500mm/grid square, w
snap distance of 10mm. This grid size will enable the model to be easily seen and ena
grid to work for the model, and with a snap distance of 10mm it means the model can be
accurately and easily. This will offer 2500 precise snap positions per grid square or 50
increments to pass over 1 grid square.Enter the values as shown below. See Grid Options on
page 3-31 and Grid Snap on page 3-31 for more details.
2-6
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υ View

With a new document open the view will be set to Home by default. This is a good overal
that can be used as a quick reference to check the model's progress. Now switch to 
view. Do this by clicking the View menu, select Change View and select Top View or by s
cut Command + 5. 

Alternatively you can change the view at the bottom of the screen, as shown below.
2-7
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Now under the Palettes menu select the Navicam. Use the zoom function of this pal
zoom in slightly on the grid. This is the primary tool for orienting the camera around a s
Over time this palette will become invaluable. See NaviCam on page D-30 for further details

Orthographic View

Now open the Renderer Options palette from the Palettes menu. Under the box labeled 
select Orthographic.This will set the view in a flat mode so the model is viewed as a 2D
Start drawing anywhere on the grid, but drawing near the center is advisable as this wil
it easier later to navigate around the scene and view the chair.
2-8
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υ Drawing The Legs

Cube

Now select the Cube tool from the Tools palette.

Hold down the shift key (holding down the shift key whilst drawing any object will const
it’s dimensions to be exactly proportional, i.e. a cube will be draw with all 3 dimensions b
equal (whereas if the shift key is not held any size cuboid shape can be drawn)) and dra
cube 40x40x40. See Cube on page G-8 for further details.

Use the info palette to check the dimensions. In the Y field of the size section enter the
1100.
2-9
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This is now the first leg of the chair. Notice that once the shape is drawn and selected ea
ner has a red square on it. This is an edit or control point and enables the shape to be 
by moving these points around. Within Microspot Modeler these edit points are called Ha
and appear on any selected object.

Duplicate

Now hold down the Option key and Shift key at the same time. Click and drag (vertic
down the original leg that has been made. Holding the Option key makes a duplicate 
item that is dragged out, whilst holding the shift key constrains the movement to one axi

Only drag this new leg out a small way with the Shift key held down.

Snapping

Now open the Cursor Options palette from the Palettes menu. Check the box that is l
Enable Snap. Then check all the boxes within the Snap Options palette. Snapping e
objects to join together. When snapping is turned on then objects will jump together whe
are close.
2-10
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Nudge

Select the new shape that has been made from the duplication and move it so snappin
it join to the bottom edge of the original shape. Now go to the Palettes menu and op
Nudge palette. In the move field enter the value 420.See Nudge on page D-33 for furthe
details.

With the second shape selected click the down arrow on the move side of the Nudge 
The leg will move 420mm into it’s correct position. With the new leg selected hold down
and select the original leg. By holding down the shift key multiple items can be selected.

Now with both objects (soon to be legs) selected hold down the Option and Shift keys
and drag out two new legs to the right of the original two. Once again don't drag them too
they both need to be positioned on the right hand edge of the original legs. Once they a
2-11



  

t arrow
ld). 

 on the
e value

  

Com-
jects.
lected
 plug-
again
t hand
se are

 

tioned on the right hand side of each leg select the Nudge palette again and hit the righ
key on the move keys (making sure the same value of 420 is input into the increment fie

Click anywhere in the window to deselect the two legs just produced, these are the two
right hand side. Select the top one and in the info palette under the size section enter th
450 in the Y field. Do the same for the other leg also. 

Gravity

Change back to the Home view momentarily using the View menu or via the shortcut 
mand + 3. In the Home view it is possible to see the effects of the Gravity plug-in on ob
Now select all four legs and under the Plug-ins menu click Gravity. Whatever object is se
in a scene the Gravity plug-in will make it’s base rest on the grid. Check that the gravity
in has worked. All the legs should be resting on the grid. Next, return to the Top view 
either by the View menu or the shortcut Command + 5. Now there are four legs. The lef
two are the back legs (the longer ones) and the right hand two are the front legs (the
much shorter).See Gravity on page C-5 for more details.
2-12
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υ Drawing The Seat

Perspective

Select the Render Options palette and change back the camera menu from Orthograph
to Perspective. This will make the home view much more realistic and assisting in e
items and viewing objects clearly.

Select the Cube tool again from the Tools palette and hold the cursor over the far top righ
of the top right hand side leg. Snapping is still enabled and so cross-hairs will appear in
ing that this specific corner is selected. Now click and drag out a cuboid across to the ot
hand side legs until its edge snaps to the nearest edge of these legs and to the bottom
the bottom left hand leg. Once this is done the right hand legs will be covered by the
drawn on top. The shape will be the seat of the chair.
2-13
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Now change the view to the Home view. This is done by either the View menu and C
view then selecting Home or by the shortcut Command + 3.

Under the Palettes menu select the Navicam and zoom in on the chair to gain a close
Notice the seat that has been drawn too thin for a chair of this size. Select the seat. Not
info palette it has a size value of 10 in the Y field. Now select one of the top handles, 
holding down the shift key, and extend the seat vertically up until its Y size is 50. If this p
difficult, zoom in further to make it easier.
2-14
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υ Drawing The Backrest

Irregular Polygon

Now go to the View menu and change to the Top view again, either by Ch
view then Top view, or by the shortcut Command + 5., and change back t
orthographic renderer. Once in the top view again (zooming in maybe req
again via the navicam to get close) from the Tools palette select the Irre
Polygon tool.

Position the cursor over the top back leg (left hand side) until cross-hairs appear on its 
left corner. Click and move across to the bottom right corner of this leg, snapping shou
this. Now click and move the cursor down to the other back leg (also on the left). The 
should now snap to the top right hand corner of this bottom leg. Click again and move ac
the top left corner of this bottom leg. Once snapping has found this corner double click 
ish the shape. A rectangle will appear positioned exactly between the two back legs. See Irreg-
ular Polygon on page G-11 for further details.

Section

Now with this new shape selected, from the Palettes menu open the Section palette. T
tion palette will display a cross sectional view of the shape selected. In this case it is a lo
rectangular section. This section is a view along the Y axis and so the dimensions of X
are shown. Notice this section has four handles. These handles are on the four corner
2-15
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rectangle. The back rest is actually curved and you will need to add two more handles
centre of the back rest and convert the straight lines to curves. If necessary move the 
palette to one side slightly so the top view can still be seen in conjunction with the sectio
ette. The model will also dynamically update whatever is altered in the section palette, so
good idea to keep an eye on this to maintain accuracy. 

Hold down the Option key with the cursor over the top right hand handle, just as in the m
ing window holding the Option key will duplicate something when dragged out. In this ca
is a handle, in the modeling window it is shapes. When a handle is selected in the secti
ette as with the modeling window it will turn yellow. Click and drag down a new handle un
is exactly half way between top and bottom and exactly in line.

The dimensions of the back rest are given as 60x420x150. Therefore with a length of 4
the middle handles will rest at 210mm. If this is slightly hard to achieve by dragging the
dles, select the handle and enter the value of 210 in the right hand field at the bottom of t
tion palette. Repeat this for the top left handle also. Now the rectangular section sho
comprised of 6 handles as shown below. See Section on page D-41 for further details.
2-16
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Bezier Handles

Now select one of the middle handles just created. Click on the bezier handle style on th
hand side of the section palette. This will now make this middle handle an editable 
repeat this for the other middle handle.

Notice now that both handles have two bezier handles either side of them which are 
points to vary the angle and radius of the curve required.

Select both the center handles by holding down the shift key and move both the handle
right. Notice that the curve will form the opposite way to that of the direction in the se
palette. If the object is rotated 180º in the section palette this will not occur. This is do
selecting the rotate (clockwise or counterclockwise) tool twice. Try and look at the mod
window whilst doing this and a curve should start to appear in the back rest. Adjust thes
dles in conjunction with the info palette, stop when the X value of the newly curved bac
is 60mm.

Bezier Handle
2-17
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Now enter the home view again either by using the View menu and Change view then Ho
by the shortcut Command + 3. Notice that the back rest is far too tall and needs to be ad
Use the Navicam again to orientate the camera around to the back of the chair so th
clear view of the back rest.
2-18
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Hold down the shift key and select a bottom handle of the back rest. Click and drag the 
up along the vertical axis until the back rest is 150mm in height. Do this whilst keeping a
on the info palette. 

Now with the back rest selected open the Nudge palette and enter the value of 20 in th
field. Move the rest down by one click, this will move it below the top of the back leg
20mm.

υ Saving The Model

Now the model is finished. At this point it is a good idea to save the model created. Und
File menu select Save and enter the name Chair 1. Save this file to your desktop or hom
tory, as long as the file is easily accessible for later tutorials. See Save on page 3-12 for furth
details.
2-19
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The model can now be positioned and rendered to give a presentation view of what ha
created. Rendering will cast the correct shadows, adjust colors according to lighting con
and make the model more photorealistic.

Select all of the parts of the model together. This can be done three ways: Firstly by click
open space and dragging a box over all of the components od the model. Secondly by u
Edit menu and using the Select All function, or finally by this function's shortcut whic
Command + A. Once all the items are selected they can be grouped. Click the Edit me
select Group, or use the shortcut, Command + G.

υ Positioning The Spot Lights

Now change to the Top view, via the View menu or the shortcut Command
Select the Rotate tool from the Tools palette and rotate the object 90º cloc
using the Shift key as a guide to enable movement in the axis planes only.
this is done re-enter the Home view, either using the View menu or via the s
cut, Command + 3.
2-20
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Now the model is ready for lighting and rendering. Under the Tools palette there is a Sp
tool, click this as the scene must now be properly lit.

Once this tool is selected, wherever the cursor is clicked on the modeling wi
a spotlight will be placed.

Note: By holding down the Control key and click/dragging a Spotlight out from a point
light will always aim at this point no matter where the final position is. We can now apply
method to the chair also. With the Spotlight tool selected hold down Control key. Now 
the cursor over the chair seat and click/drag out a light towards the edge of the grid nea
screen. A light will appear and will remain focused on the chair until the Control ke
released.
2-21
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By holding down Shift the light can be dragged out along the Z axis to a suitable dis
Select the Info palette with the light selected. In the Y field the value should be some
between 500 and 1000. Change this value to 2750mm. Once doing this the light is no 
directed at the chair. In the Tools palette choose the Light director tool.

With the light still selected aim the cursor, which should now be a cross hair at the cha
and click. This will direct the light's focus exactly to this point. Again with the light s
selected select the Info palette and adjust the light setting sliders to approximately the
ues: See Spot Light on page G-28 for further details.
2-22
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υ Setting The Sun Direction

Once this is set the sun settings can be adjusted. Select the Tools palette and click on
Direction tool. 

Once this is clicked the view will change to a top view of the scene. The direction of the
light is represented by a thin red line that is set by default to 45º between the X and Z 
axis lines. The line has a handle on the end which can be dragged around to alter the su
tion and elevation. In this instance it will be easier to enter numeric values of angle and
tion for the sun rather than trying to make it shine exactly from the top view.

To do this hold down the Option key and re-click the Sunlight tool. This will bring up a 
logue box of sun setting. Enter these values in the fields and click OK. See Sun Direction on
page H-11 for further details.
2-23
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Open the Lights palette under the Palettes menu. This is the global controls settings 
Sunlight, Ambient light and Spotlights. Turn the Sun Brightness slider down to roughly 1
its maximum value, with the addition of the spot light the sun does not have to be so in
This will also avoid any overlapping shadows that might occur from two prominent 
sources pointing in the same direction. See Lights on page D-29 for further details.

υ Base Plate

Go back to the Home view, via the View menu or by the shortcut Command + 3. The
piece of this model is a floor plane. This will enable shadows to be cast and give the sea
depth and realism. Select the Base Plate plug-in from the Plug-ins palette. Now you will 
a floor plane has been added to the document, at the same height as the grid.

With the chair selected select the Info palette and click the color block labeled surface
The Apple default color wheel spectrum will appear. Pick a color that is as close the a 
dark beige as you can get, click OK. Now select the floor plane and repeat this coloring p
but this time make the floor plane white.

υ Final Render

Go back to the Home view if you’re not already there, via the View menu or by the sho
Command + 3. Once the Home view is established the whole scene is visible, check tha
thing is in place, chair position, base plate, lighting, etc.
2-24
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Select the chair and use the Look at selected function, the shortcut being Command + 
zoom in on the chair to get a close up detailed view it the final model. This can be do
using the Navicam zoom tool.

Renderer Options

Go to the Palettes menu and now open Renderer Options. This is the palette used to co
output of the final image and the quality of the scene when rendered. At present the view
to Interactive, this is a plane shader view which offers a fast but low quality color filled ap
ance enabling the user to work quickly and easily with the model. The model can a
viewed in wire frame, which shows an outline mesh frame of each component. See Renderer
Options on page D-34 for further details.
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Microspot Preview Renderer

Select the Renderer pop-up menu in Render Options and click Preview renderer. This w
a quick render with low quality settings to give the user a visual idea of colors and sha
under render conditions. 

Now check over the Preview Renderer to make sure that the lighting is not too bright and
is no double shadowing and the model looks situated on the floor.
2-26
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Microspot Renderer

Now go back to the Render Options palette and from the Renderer box select the Mic
Renderer with the Option key held down. This will bring up the Render Options win
Within the Render Options screen there are several different areas of adjustment. 

Note the above settings will output a good quality rendering with smooth anti-aliased 
and clean lines, accurate shadows and soft edges. However the higher the render quali
fied the more data needs to be calculated, and so the render will take much longer. As 
simple chair choose the settings as above in the Renderer Options palette and click OK

The final render is now complete. 
2-27
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To export this image go to the File menu and Export, as Picture and this will export a PIC
to a specified (by the user) location. A dialogue box will appear with several settings on
ity. The scene will now render for exporting. Once this is done a save dialog box will a
labeled export image as. Within here you can select the file type, which can be a JPEG
TIFF and other digital image formats.

Finally select the chair and under Options, select Primitve. This will mean the chair will n
able to be ungrouped by mistake, as it needs to be Dismantleable to be ungrouped. No
the file menu select save, and save the file again, as we have altered the file with lights 
2-28
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TUTORIAL TWO

Please note that this tutorial should only be started upon completion of the first tutorial M
ing the basic chair. Alternatively open the file named Chair 1 from the samples files 
installed with this program. This will then form the base for which the second tutorial will
you through modifying the chair using more advanced and powerful editing tools.

υ Getting Ready

Reopen the file named Chair 1 that was saved from the first tutorial. See Open on page 3-8 fo
further details.

Use the Navicam to change the camera position so that the chair can be easily seen. S
chair and under the options menu select Dismantleable and then from the Edit menu
Ungroup. This will now make the model all of its component parts again which can be u
aid the positioning of the new parts, with regard to snapping and sizing. 

Note: To avoid trouble later on in the tutorial, please ensure that the model is correctly d
tled and ungrouped.
2-29
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υ Drawing The Cushion Seat

Select the seat and note that its vertical size is 50 mm. Now the seat is going to be resi
to help with this, check the Cursor Options palette. Snapping will have to be disabled m
tarily otherwise when resizing the seat the top edge that is being moved will snap to the 
and will result in a seat that is of 0 mm thickness. Select one of the top handles whilst h
down Shift and move the handle vertically down until it becomes 30 mm in height.

Now the semi cushion style seat will be added. Change the view to the Front view. Do t
the View menu and Change view then selecting Front or by the shortcut Comman
Depending on the orientation of the chair it should be a side on view, but if the chair ha
moved then use the Navicam so a side on view of the chair is achieved, as below. 

As well as this, enter the Renderer Options palette and change the drop down menu 
Camera to Orthographic. This will give you a flat 2D side view of the chair. Open the C
Options palette and make sure that the Enable Snap check box is marked with a tick. F
method snapping is very important. 
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Now select the Irregular Polygon tool from the Tools palette. 

Position the cursor on the top left corner of the now thinner seat that has just been r
Cross-hairs will appear to indicate the cursor’s position. Once in the correct position, cl
start the polygon. Move the cursor to the right whilst holding down shift until it snaps t
corner section where the top right edge of the seat meets the chair leg coming down
again. Now move the cursor up until it snaps again (if you feel the need to use the Shif
tion with this vertical movement to ensure a vertical line then fine, but snapping should b
quate) at the mid point of the back leg and click again. Now hold down shift and move
across the chair until it snaps in line and directly above the original start point of this pol
once in position double click to finish the polygon.
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Now a cuboid will be sitting on top of the smaller seat. Open the Section palette with the 
formed rectangle still selected and, if necessary, move and resize the section palette so
modeling window can be seen as well. A sectional outline of the new seat top will appear
that the object has 4 handles in the section palette and that one of these handles is grey
the origin handle and indicates the start point of the polygon.

Notice that the polygon was started on the bottom left hand side of the seat. Now in the 
palette, the origin handle is on the bottom right hand side of the polygon. This is an imp
fact to note. It only means that the section palette is taking it's sectional view from the
side of the chair. To keep things as intuitive as possible, and to avoid doing things back
this object section should be flipped using the flip (along vertical plane) tool. 

Place the cursor over the top left handle. Note with the Option key held down over the ha
small cross appears. This indicates that a duplication can be made. Just as with the m
window, holding down the option key and dragging out from an object makes a duplicate
in the section palette holding down the option key and dragging or Option dragging ma
new handle. Now select this handle, and it will turn yellow to indicate its selection. O
selected Option drag out a new handle below the original until it rests at a Y value of 50
Now select the top left handle, and move it until it has an X value of -130mm. With the h
still selected change its editing properties to a bezier curve. On the right hand side of th
tion palette are a range of tools for orientating the view of the section, zooming in on se
handles, and changing their editing properties. In this case a bezier will make the ha
curve with two in line editing points.
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These two control points will control the size and radius of the curvature produced. Pla
these control points to get an idea of the effect they have on a curve and a shape. Once
happy with the effect. Select the top right handle and enter a Y value of 50 mm, or phy
move it down. Move the left hand control handle (still maintaining parallel to the section)
it is vertically in line with the section's left edge handles.  Now the seat top will have a g
curve to it. 

Close the section palette and return to the home view, zoom in again using the Navica
ette. The newly formed curve seat top will have the dimensions; 460 x 70 x 500, check 
the info palette.
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υ Changing The Back Legs

Now the back legs will be changed. Utilizing the old legs from tutorial #1 for width and he
new legs can be modeled quickly. Just as done previously orientate the view so that the
the chair is shown, or by using the last view shortcut Command + 9.

Select the Irregular polygon tool from the Tools palette. Place the cursor on the top bac
of the existing leg, with snapping still on this should be controlled easily by the cross-hair
will mark the location. Now click and move the mouse down whilst holding down shift u
the bottom corner is reached, now click again. Whilst holding down shift again move out 
right a short way, click again. Now hold down shift and move the cursor back up the len
the original leg until it snaps at the top, double click to finish this leg. There is now a se
leg next to the original leg. 

Select this newly created leg and enter the Section palette.
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Above this is the vertical flip tool which will set the shape in exactly the same orientati
what is seen on screen. Click this once also, this will be useful as when editing in the s
palette the modeling window will dynamically update and so the degree of adjustment o
piece can be suitably measured.

Once this is done select the top right hand handle and using the Option drag metho
down the option key, then click drag out) to produce a new handle directly above the e
one. Now select the original handle, make a note of its position with respect to X and 
move it down, the newly formed handle will now take its place with the noted co-ordinate
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Now with this newly positioned handle move it sideways until the separation between
and the top left handle is 40 mm, the co-ordinate fields will be needed to achieve this. 

Now move to the bottom of the section and select the bottom right hand handle and mo
handle until the separation between this and the bottom left handle is 70 mm. Select the
that is sitting alone between the top and bottom sets of handles. Enter a value of -550
the X field. Make this handle a bezier curve and adjust its control points to be vertical,
make this handle to be 70 mm away from the opposite side of the section. This now g
new leg with a slight curve in the back.
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Close the section palette and change to the Home view in the modeling window, Comma
is the shortcut for this. Remember also to change back the Camera style under the 
Options palette back to Perspective. Notice that the leg produced is far too wide.

Switch to the top view via the short cut Command + 5 or the View drop down menu, chec
the Camera style is in Orthographic under the Renderer options palette, and zoom in
back legs. Select the top right hand handle whilst holding down shift and drag it down to 
the leg's width. In this instance it is the Z value that is being changed, so stop when the
40 mm wide, this should easily be achieved using snapping.
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Once this is done, the leg can be duplicated. Hold down the shift and option key and clic
a new leg up until it snaps in line with the original top leg. Again this is done by using the
ful Option drag method. Alternatively the leg can be duplicated by the Edit menu and sel
Duplicate or by the shortcut Command + D. This however offsets the duplicated object b
mm in the X axis. This will then have to be repositioned to fit the model so in this case it i
ier to use the Option drag method.
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Now there are two new legs for the chair.

Hold down shift and select both the two original back legs and the back rest and then
them. Reselect both of the new legs that have been made and move them to the left. H
down the control key in this instance is really a personal preference, but it will allow the le
positioned on the seat without too many problems. By holding down the control key the Y
movement is locked and so things can only move in the X and Z plane. Also Snappin
make moving much more accurate. Change to the Home view momentarily to check th
looks fine and come back to the Top view. 

υ Changing The Back Rest

Pipe Tool

Use the Navicam to zoom in on the back legs. Go to the Tools palette and 
the Pipe tool. Now hold down the Option key and re-click the Pipe tool. This 
bring up the Pipe Options dialogue box. 

In the field labeled Pipe diameter enter the value 25 mm and check the box marked En
and click OK.

Now position the cursor until it snaps to the middle of the back legs on the inside edge.
and move the mouse down until it snaps to the inside edge of the opposite leg and doub
to finish the pipe. Select the newly formed pipe and move it slightly to the left, until the 
edge snaps to the central snap line of the back legs. See Animation Draw Path on page G-4 fo
further details.
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Once this is done enter the Info palette with the pipe still selected and change the Y pos
1088, this will place the pipe right at the top of the back legs. 

Change to the Home view via the View menu or the shortcut Command + 3, and chang
the Camera style under Render options to Perspective. Notice the position of the pip
will form part of a new back rest for this chair. With the pipe selected open the Nudge p
and enter a value of 40 in the Move field. Now nudge the pipe down 1 click or 40 mm. 

Now this pipe will be duplicated to produce a fully supporting back rest. Select the pip
using the Option drag method produce a duplicate directly below the original one, stop
the top of the new pipe snaps to the bottom edge of the original pipe, shift may also be 
here. Now select the new pipe and nudge this down 40 mm.
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Repeat this duplication and nudge, until there are 4 pipes in total.
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The model is now finished. Color and render as in tutorial #1 to see a final presentation 
2-42



s doc-

select

tyle to

he one
ion pal-
wed at
to see
TUTORIAL THREE

Before this tutorial, it is advisable to have completed the first two tutorials. 

Reopen the chair from the second tutorial. Alternatively open tutorial #2 from the sample
uments folder installed with the program.

Select the chair and from the Options menu dismantle it. Now from the Edit menu 
Ungroup. Now the chair is in individual parts again as they were modelled before. 

υ Altering The Back Legs

Change from the Home view to the Front view (Command + 8) and set the camera s
Orthographic, as below:

Select one of the back legs, preferably the one on the right of the model as it is now t
nearest to the camera view when in Front view. From the palettes menu select the Sect
ette. Make sure the Section palette is positioned so that the modelling window can be vie
the same time. Remember that the model will dynamically update and so it is useful 
what effect the section palette is having.
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Select the handle in the middle of the leg that was made a bezier curve in the second 
and make it a straight line. Now with this handle still selected make its X and Y values 
500 respectively.

Using the Option drag method duplicate this handle directly below it and make its Y po
450. There are now 2 handles close together in the middle of the section on its right edg
replicate these handles and their positions on the left hand side of the section bearing 
that there X value will be -40. Once this is done this 4 handles make a small square.

Now select the top right hand side handle and enter the values X = 60 and Y = 1100. 
left hand top handle enter the values X = 20 and Y = 1100. Now select the bottom righ
handle and change its X position to 20, now select the bottom left handle and make its X
-20.

Close the section palette and change to the Top view. The leg at the bottom is the leg t
just been altered. Select the top leg and delete it. Now reselect the altered new leg an
cate it into the position of the deleted one. Change views back to the Home view and che
the new legs are correctly positioned at the back of the seat.
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υ Changing The Back Rest

Select the 4 bars that made the back rest in the second tutorial, and delete them. Go ba
top view and using Navicam orientate the camera so it is focused on the back legs. Sel
of the two legs and Option drag a new leg out between the other two. Allow Snapping to
tion this leg in the middle of the chair and change its Z size value to 420. This will then m
long enough to touch each outer leg. Change back to the Home view again and then 
shortcut Command + 1 to look at the selected leg directly.
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Now orientate the camera around using Navicam to get a good look at this new leg th
been created. Select this new leg and open the Section palette. Just as before utilize the
rotate tools in the Section palette to make the selected leg of an orientation that is unde
able to you. Select the bottom left handle that extends the leg to the floor. Once this is s
click the delete or Trash tool in the section palette and the handle will disappear. No
object is left with a point.
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Notice that the bottom right handle is the origin handle, denoted by its grey color. This h
in most cases can not be deleted. Instead the handle above this one (the handle that m
the bottom right handle of the handles in a square formation) can be deleted and the orig
dle can take its place. Notice also that the object is now much smaller as the volume
model has been quite radically altered due to this removal. The modelling window s
express this change well as the object is no longer a leg but more like a back rest.

Now return to the Home view and select the curved seat top that was made in the seco
rial and delete it. Underneath is a much thinner seat top that is only 30 mm in height. C
to the Front view again using the shortcut Command + 8 and select this thinner seat top
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Without using shift select the top left handle and move it up until the Y value is 50 mm.
that by not using shift in this operation snapping will control the size in both the X and Z d
tions by a single snapping line on the front left corner.

Now change the view again back to the Home view, zoom in on the seat a small amou
select the Irregular polygon tool from the Tools palette. Position the cursor on the neare
ner of the seat top and once snapping has given a suitable corner position click to star
polygon. Hold down shift and move the cursor up until it snaps to be in line with the top o
back rest and click again. Now move across the seat face, still holding down shift until
ping takes the cursor to the far front edge of the seat size. Click again and move ve
down until the cursor snaps to this corner point of the seat, and double click to finish. N
cuboid should appear that covers the seat.
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Notice that due to the orientation at which the model was started the X axis is in the Y
direction. This does not matter really for these purposes. With this object selected en
value; 470, 60, 230 for the size of X, Y and Z respectively. Now with the object still sele
open the Section palette. The object might open in the section palette with a slightly dif
orientation to that on screen. Use rotate tools in the section palette to alter this to look th
as the model’s orientation.

Now select the top right hand handle and make a duplication of this handle. Position the
cated handle between the two original handles.

Now select these top 2 original handles (not the middle one) and move them both do
mm, this is easy to achieve as it is only 2 grid snap moves away and it is quicker to do 
feel, rather than typing in the increments by hand for each handle.
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Now repeat this for the bottom handles also, so the final result is a long diamond shaped
that has a point at each end.

Select the middle handle at the top of the object an make it a bezier from the tools menu
Section palette. Position its control handles so they are completely horizontal and are th
width as the original outer handles. Do the same for the bottom middle handle.
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Now this object is ready, close the section palette. With the object selected enter the In
ette and click on the surface color square. Change its color to anything, so long as it co
with the default grey color. Now change view to the Right view, either by using the View m
or the shortcut for this is Command + 6.

Set the camera style to orthographic. Select the object that will be used as a cut out an
cate this to the left and right so there are 3 in total. When duplicating make sure that sn
positions the duplicated one edge to edge with the original, so they are all in line, and n
each other.
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Once there are 3 cut outs open the Nudge palette and enter a value of 50 in the mov
Move the left hand side cut out 50 mm to the left, away from the central one. Now mov
right hand cut out 50 mm away from the central one also.

Once this is done change to the Front view and drag a box over the cut outs. This is
make sure that all 3 are selected. Once all 3 are selected, hold down the Shift key an
them to the right into the back rest. Stop when they are roughly central, i.e. half is sticki
the back and half out of the front.
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Construct Tool

Change back to the Home view and orientate the camera to get a clear view of the se
and cut outs. Now from the Palettes menu open the Construct palette. The construct too
objects to be used in conjunction with other objects to make complex shapes or comp
sections and profiles that are too complicated to create with one shape. Select the 3 cu
they are not already selected and in the Construct palette click the Subtraction button.

This will go dark as it indicates that this is the tool or action that will be applied when 
intersected are assigned A or B. This idea is best explained by giving an example. If a 
sphere is placed on top of a cube and pushed inside so only half the sphere is showin
the top of the cube then this is an Intersection. The options available now for this inters
are Add, Subtract, Split and Intersect. Each tool does very specific things but for now on
Subtract tool is needed. Assigning A or B to objects allows the program to calculate wha
be done to an object or group of objects. An object can either be assigned A or B. Pict
example again or even try this on a new document the cube and sphere. If the cube and
are both assigned A or both assigned B then nothing will happen.
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The tools are used to always express operations in terms of A and B, for example us
subtract operation: A subtracting B will result in a loss of area from A. So if the sphe
assigned A and the cube B then if; A subtracting B from it will result in half the sphere b
cut away.
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Now think if these were the other way around i.e. the sphere was B and the cube was
the cube would end up with half a sphere shape cut out of its top.See Construct on page D-1
for further details.

Going back to the model, assign the 3 cut outs B. Now select the central back rest made
and assign this A. Depending on processor power available to the Construct Idler the 
ling window should show a preview of this operation before it is made permanent. At pr
both A and B have individual bounding boxes and their own specific geometry. Once 
made permanent however the geometry of the bounding box will change. If the Construc
has performed the operation preview then 3 exact cut outs should appear in the back re
2-55



sier to
ke per-
am. A
ow fin-

. Make
uickly

d posi-
en this
n it is
ilst

 and 40
Now it is easier to see why the cut outs should be a different color as now it is much ea
see what the operation has actually done to the back rest. Once this looks fine click Ma
manent, wait for a few seconds as this operation will now be implemented by the progr
status bar should appear explaining that triangles are being split. With the back rest n
ished change to the Front view via the View menu or the shortcut Command + 8.

υ Drawing The Chair Supports

Set the camera style to Orthographic and select the Cube tool from the Tools palette
sure that snapping is on in the Cursor options palette (to toggle snapping on and off q
hold down Control and press the Spacebar once, doing this again will turn it back on) an
tion the cursor so snapping occurs on the bottom right hand corner of the front leg. Wh
is in position click and drag out a rectangle that is 60 mm in the Y direction and stop whe
roughly 300 mm in the X direction. Now switch off snapping and hold down Shift wh
selecting the same handle and drag the rectangle out longer until it is 450 mm in length,
mm in height.

Finally turn snapping on again.
2-56



 front
 be the

 key
s to the
Note: that the Z size of the object is only 10 mm, change this to 40 mm. Now select the
leg and note its Z position. Reselect the object just drawn and change its Z position to
same.

This object will form part of the foot rest/ chair supports. Now move it up using the Shift
to preserve its position between the front and back legs. Stop when the foot rest snap
middle of the front leg and is positioned centrally on it.
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Now with this rest still selected enter the Info palette again and change the X value o
from 450 to 470 mm this will give the appearance that the foot rest is fixed as part of the
structure. Once this has been finished return to the Home view to observe the results.

Now use the Navicam to orientate the scene around so that both sets of legs can be
those with the foot rest and those without. Now select the foot rest just made and hold
the shift key. Option drag a duplication of this rest out across to the other legs. Stop wh
new rest falls completely in line with the front and back legs. Snapping should aid a grea
with this operation. If for one reason or another the position can not exactly be obtain
moving with the Shift key then note the Z position of the front or back legs and make thi
rest the same just as with the previous leg.
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Now Option drag a third rest out again using the Shift key from one of these two new res
and roughly position it in the middle of these two. Now select the two original rests that 
position and group them together, either by the Edit menu or the shortcut Command + G

Once these are grouped reselect the middle rest that has just been made and using Shi
strain it to the global axis move it until it snaps to the centre of this newly formed group o
two outer rests. Now open the Nudge palette. In the rotate field enter 90 and nudge th
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 only
round until it is perpendicular to the group of two outer rests. Finally resize it so it is now
460mm long.

Now the model is finished. Save the model to your home directory and call it Chair #3.
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TUTORIAL FOUR

Reopen the file saved as Chair 3. If the third tutorial has not been completed then open
named Chair 3 from the sample files folder installed with the program.

Select the chair, Dismantle and Ungroup it so it can be edited by individual parts. Cha
the Top view and orientate the camera to have a clear view of the seat top. Select the Ir
polygon tool from the Tools palette. Open Cursor Options under the palettes menu and
that Snapping is turned on, it will be needed extensively throughout this part of the mode

υ The Final Seat

Now position the cursor over the bottom left hand corner of the seat and click to start the
gon. Move the cursor to the right until snapping finds the bottom right hand corner and
again. Now move the cursor up either using the Shift function or by allowing snap to guid
cursor, locate the top right hand corner of the seat and click again. Now move back ac
the top left hand corner of the seat and double click to finish the Irregular polygon.
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With the object still selected open the Section palette and select the top left hand h
Option drag a new handle out from this 40 mm to the right. Do the same for the botto
hand handle also.

Now select the bottom right handle and duplicate a new handle directly 40 mm abov
Repeat this for the top right handle making the duplication 40 mm below this one. Ret
the four handles on the left of the model now. Select the original top left handle and m
down 40 mm, this will make a clean 45º chamfer. Next select the bottom left handle and
this up to again make a 45º chamfer.With the right handles move the original 2 to the left
mm to finish a new eight sided shape.
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With these four original handles that have just been moved, use the Bezier curve tool fro
tools on the right hand side of the Section palette. Once these beziers have been ma
important to note that on the left they act in a vertical direction and on the right in a horiz
direction however the result is just the same. For all four beziers make the control points
line with the handles they come from and the outer control point that extends past the
should be shortened to rest in line with the other handle each corner section. The re
effect is a rectangle (almost square) with four rounded edges. Close the Section pale
change back to the Home view (Command + 3).
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Select the original seat block that rests on top of the legs and delete it. Depending on Sn
variations when the original section was drawn the new block could be sitting below the g
on top of the original seat block. Either way relocate this so that its bottom edge rests 
top edge of the chair legs. This will now form a new seat. Once this is in position notice 
is still far too high to be a seat top. Using the Snapping shortcut, Control + Space to dea
Snapping and resize the new seat top. Do this by selecting a top handle and whilst h
down Shift change the size of this seat to be 50 mm in height.

υ The Final Legs

Select all of the inner foot rests that were drawn in the third tutorial and delete them. No
legs will be drawn independently of the rest of the model as each leg is a more detail
complex section than those previously made. Move the camera orientation away fro
model and into an area of the grid where work can be done clear of other objects. Us
Control + Space shortcut or by checking the Cursor Options palette deactivate Snapping
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Lathe Tool

Select the lathe tool from the Tools menu. Click on the grid and follow the g
line vertically up a reasonable way and click. Now hold down the Shift key 
move the cursor out to the left or right a short distance (remember this is go
be a long thin chair leg) and click again. Still with the Shift key held down m
down vertically until the cursor roughly meets the floor and double click to fin

At the stage a cylinder should appear. It is still rough in terms of shape and dimensions
stage as all of the sectional adjustments will be added in the Section Palette. With the c
still selected enter the values 80, 250, and 80 in the size fields of X, Y and Z respectively

Now open the Section palette. Notice that the cylinder is represented by a single line 
handles, one of these being the origin handle. Use the horizontal flip tool from the tools 
right hand side of the section palette to make the line sit above the X axis. The far left ha
editable and so from this Option drag out 6 more handles to the left so that there are 8 i
These handles will be used now to make a chair leg that appears to be lathed.
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Drag a box over all of the handles including the origin and (hold Shift down after a han
selected to control axial direction. Note if Shift is held down before a handle is selecte
one will be deselected when clicked on) select and hold a handle. Now using the Shift ke
the cylinder to the right until the left most handle rests on the Y=0 line. Notice the dyn
update in the modeling window as the cylinder moves up to sit on the grid. This is do
make dimensioning easier from now on for this complex curved section.
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Working left to right select the first handle, its value should be 0, -40 in terms of X a
respectively. Change these to 0, 18. Select the second handle and change the values t
Change handle three’s values to 50, 20 and handle 4 will sit directly below this at 50, 17

The fifth handle is a bezier curve with coordinate value of 246, 35. For this handle ma
control handles horizontal and extend them to be almost vertically in line with handle 6
position of handle 6 is 330, 25. The handles of handle 5 should extend roughly half th
tance between handle 6 and 3-4.

Handle 7 has coordinate values of 360,33 and is also a bezier. With handle 7 make the
handles horizontal and extend them until the left handle is directly over handle 6. The
handle is the origin handle and should rest at 450, 33.

Close the section palette and select the original front legs. Delete these two legs and ch
the Top view (Command + 5). Select the new leg and make a duplication of it. Open the C
Options palette and enable Snapping. Now select the duplicated leg and move it into p
so that its top left hand corner snaps to the top left hand corner of the rounded seat to
move the original leg into position below this one to snap in place on the bottom left han
ner. Change back to the Home view (Command + 3) and check the position of the legs.
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Make sure that both of them are resting with their top edge on the bottom edge of th
Check that the back is ungrouped, and that there are 2 legs and one back rest. Select 
rest and delete it as a new one will now be modeled using several of the techniques use
third tutorial.
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Orientate the camera so the view of the chair is side on or change to the Front view (Com
+ 8) and select the back leg nearest the camera. Now with this leg selected open the 
palette.

Select the bottom left hand handle and delete it using the delete/trash tool in the secti
ette’s tool area. The leg is left with a spike which forms at the origin handle. Above this 
small group of 4 handles in a square shape. Delete the bottom right hand handle of the
Now select the origin handle and move it into position to reform this small group. 
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Close the Section palette and if not already change the camera view to the Front view
mand + 8) and select this now shortened leg. As with the third tutorial this leg will becom
back rest of the chair. Open the Nudge palette and in the Move field enter the value of 5
Now nudge the back rest 50 mm to the left. This will push it into the seat top and m
appear more secure and stable. Now change back to the Home view and select this so
back rest. Hold down shift and move this to the left until it snaps to the centre of the
Select the other leg that has not been altered and delete it also.

Reselect the rest that is positioned in the middle of the seat and change its Z size in t
palette from 40 to 460 mm. Revert back to the Front view again and drag a box over the 
legs. Use the Option drag method in conjunction with Shift to duplicate these 2 front le
the back. Position them at the furthest rear edge of the seat.
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υ The Final Supports

Now with these 2 back legs still selected (if they have accidentally become unselected
another box over them) open the Nudge palette and enter a value of 5 in the move fie
move the legs to left 5 mm. Now drag a box over the front 2 legs and nudge these to al
this time to the right 5 mm. This next stage will concentrate on modelling solely in a 3D
so the use of axis guides including Shift function, and Snapping will be very impor
Change to the Home view (Command + 3) and select the Pipe tool from the Tools palet
the Option key held down. Holding down the Option key will bring up the Pipe Options
logue box where the diameter and attributes of each pipe can be set. Enter a value of 20
the Pipe diameter field and click OK.
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Now position the cursor over the top left (furthest away) corner of the seat. Snapping s
position the cursor accurately on the corner and when it does click to start the pipe. Mo
cursor around and note that a cord is attached to it. This represents the direction of the p
the cursor being its finish point. Note also that if after the first click the mouse is clicke
held down, dragging the mouse out now in any given direction will result in a curve being
duced. This is particularly useful for making bends in pipes, etc. Experimentation with
tool is the best way to learn its parameters. Now hold down the shift key and move the 
along the Z axis to the right until it snaps to the corner of the seat that is nearest the c
Once snapping has found this corner double click to finish and a pipe the length of the se
be produced.
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With this new pipe still selected open the Info palette and change the value of Y in the po
area to 120. This will put this pipe at exactly the right height as it will make up part of a
foot rest. Now change to the Right view (Command + 6) and zoom in slightly on the foo
that has just been produced. Select the foot rest and in the Info palette enter the value o
the Z field of the Size area.Now make 2 duplications of this rest, one directly to the le
snaps to the middle of the original with its right hand end, and one to the right that also
in this way but with its left hand edge. It is important that these new rests are snapped
right place in relation to the original otherwise they will not align.
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Now select both of the new foot rests that have just been duplicated. Open the Nudge
and in the Rotate field enter the value of 90º. Now rotate both of these rests 90º, eithe
left or right it does not matter. In this present view all that should be seen now of the rest
original one, still length ways and now 2 circular sections. Switch back to the Home view
zoom in a short way to see more of the foot rests. The rests will form a H shape. Sele
rests and whilst holding down Shift move all 3 along the X axis back under the seat. 
these back until the middle of the original rest (the rest in line with the Z axis) snaps to th
tre of the seat. This should be easy to achieve but may not work exactly first time.

Move the 3 back and forth along this axis until snapping finds the position. Notice that th
duplicated rests are too long for the size of the chair. Select both of these rests. This
done in two ways; at present all 3 rests are selected so click onto the grid and they will b
lected. Now hold down Shift and select them both. Alternatively when all 3 are still sele
hold down shift and click on the original rest and it will be deselected from the grou
selected objects. Sometimes this is a much quicker method of gathering groups of obje
selecting them all with the shortcut Command + A and then Shift deselecting the ones t
not needed. Once the two rests are selected group them together, by either the Edit men
shortcut Command + G.
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In the Info palette change the X value of Size from 440 to 400. This will put them insid
chair legs and thus making it a more solid looking chair. At present the back rest of the 
solid since one of the old legs was extended to fill the width of the seat top. This next sta
produce an irregular curved shape that will be used to produce a cut out section in th
rest.

υ The Final Backrest

Zoom out a small way until there is sufficient room on the gird to draw a separate o
Switch to the Top view (Command + 5) as it is much easier to draw in this view and then
the item later rather than draw in the Home view and have to navigate the modelling w
around the object just to understand what is being made. This way when it is edited in th
tion palette the dynamic update will show exactly what the final object will look like. Open
Cursor options palette and turn off Snapping as it is not needed in this instance and coul
problems whilst trying to draw if the cursor is near the chair at all. This next piece will b
object used as a cut out, just as with the third tutorial. A section will be produced and in
to the back rest to make an intersection using the Construct palette. Draw out a long th
angle. Make sure to use Shift and only draw 3 handles with the third being a double c
finish the object. Otherwise the rectangle will have one to many handles at its origin poi
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will not be exact. Once this is drawn enter the Info palette and make the shape 600 mm
160 mm wide and 200 mm deep.

Now open the Section palette (check that the 4 handles are in line and make a perfect
gle). On the top long edge of this new object create 2 new handles, one on the left and
the right. On the far right, the origin handle should be at co-ordinates 0,0. If this is correc
all the other handles can be positioned using their X and Y values (adjust the model by
ging a box over all the handles and moving the object until the origin handle rests on th
coordinate).
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Working clockwise from the origin handle select the bottom left hand handle and enter th
ues -550, 0 for X and Y respectively. For the top left hand handle enter the values -550, 4
handle to the right of this which is a duplicated handle should have the co-ordinates -44
Make this handle a bezier curve and adjust its control handles to sit horizontal, the exp
of these handles will have to be referenced from the picture below as there is no real de
of size for this. The next handle is a duplicated one and should have the coordinates; -2
this is also a bezier curve with horizontal handles. The original right hand (top) widget h
coordinates 0, 60 and the origin handle just below this has the coordinates 0, 0 as pre
discussed. Now close the Section palette. 

Once the shape looks right then switch back to the Home view (Command + 3). Op
Nudge palette and in the rotate field enter 90 (if it is not already entered). Using the Na
orientate the camera around to be facing the curved edge of the cut out.

Now use the rotate left arrow tool (the tool that is a curled arrow on the left of the clust
rotate the cut out through 270º. This will place the cut out with the larger curve end on th
tom. Now using the Nudge palette again rotate the cut out 180º to the left or right (i
instance it does not matter as the cut out is just being flipped around) about the Y axis 
the flat edge faces the camera and the curved edge points away. Return to the Home v
now the cut out is in the correct orientation to be placed in the back rest.
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With the cut out still selected enter the Info palette and in the Y position field change the
to 825. Open the Cursor options palette and re-enable Snapping as this will be useful a
the cut out positioning. Now change the view to the Top view (Command + 5) and mov
cut out until it snaps to the bottom edge of the back rest with its own bottom edge (ensu
its Y position is still 825 mm). Change view again to the Right view (Command + 6) and
the cut out selected use the Command + 1 function to look at the selected object. Op
Nudge palette and enter a value of 25 in the move field. Nudge the cut out (who’s curve
should be facing inwards, if not then use the nudge palette to rotate this 180 degrees 
25 mm down and 75 mm in towards the centre.
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Now holding down Shift, Option drag a new cut out to the left and position this one ed
edge with the back rest. This cut out will need to be rotated 180º to mirror the cut out 
right. Now use the Nudge palette again to nudge this in 75 mm. It might be easier to rep
this duplicated cut out on the corner of the back rest at 825 mm above the grid (Y positio
then nudge it down 25 mm.

Change to the Front view (Command + 8) and drag a box over the cut outs to select b
them. Now with the shift key held down move them to the right so they rest half in and ha
of the back rest. This does not have to be accurate, as long as the cut outs are clean th
ensure a precise and full cut is produced. Change back to the Home view and orient
camera around into a position that will give a clear view of the back rest when the constr
is applied.
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Open the Construct palette from the Palettes menu and select the Subtract tool (this w
out to indicate this is the process that will be performed). Now select both the cut out o
and in the Construct palette assign both of these B. Now select the back rest and assign

Note: Depending on processor power the Construct Idler should update this operation an
a preview of the intersection that has been made by the two assignations. A slower pro
will take longer to update this preview but it will occur.
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If this looks fine, click Make Permanent. Move the camera into a position where the top 
seat is easily seen and both ends are visible. Do not use an Orthographic view like the
view (Command + 6) for this final operation as all 4 handles at the top of the back rest n
be seen. Select the Irregular polygon tool from the Tools palette and position the cursor
nearest back corner of the back rest. Now the last part of this final chair is to produce a g
top or crown to the back rest making the chair more detailed and slightly taller than the o
Click to begin and whilst holding down shift move the cursor across the back rest to the 
site back corner and click again. Now move vertically up a short way (say 1/3 the dis
across the back rest) and click again. Move back across the back rest until the cursor s
the centre of the back rest and click, then move on to the end of the back rest above the 
start point and double click to finish. This produces a block that rests with its back edge 
back edge of the back rest and the front extending out 500 mm in the Z direction.

Turn off Snapping using the shortcut Control + Space (this may need to be checked in th
sor Options palette) and select one of the handles at the end of the new back rest crow
down shift and drag this back towards the back rest along the Z axis. Stop when the bac
40 mm thick. With the crown still selected open the Section palette and duplicate the 2 to
dles. Make the duplications rest 60 mm in towards the centre from their originals.
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The top left and right corner originals and the duplicates must have a height of 40 mm.
the middle handle and change it to a bezier and change its height to 80 mm. Now make 
duplication handles both beziers and make their handle handles horizontal and extend th
to stop just before the outer handles, as long as they are both equal this can be left to p
choice. Apply the same to the middle handle, extending its handles out to give a gentle 
looking curve. Close the Section palette and return to the Home view. 
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Select all the components using the shortcut Command + A and group them together
shortcut Command + G.

Now the model can be colored, textured and rendered. Save the file as chair 4.
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WINDOWS AND DOORS TUTORIAL

This short tutorial will outline the basic operation to produce a door and a window that c
used in conjunction with Microspot Interiors. 

Modeling a window or door is just like modeling anything else in Microspot Modeler, how
there are a few steps that must then be taken in order to turn a simple model into a door
dow. Once this is achieved, the item can be successfully positioned on a wall and can 
manipulated to satisfy individual criteria.

Understanding why a door or window is different from just any other model is easy. W
moving the model from Modeler to Interiors, Interiors needs to know that the supplied m
is a door or window. It needs to know this as it will need it to position the model corre
when it is put into a wall. For example, a door needs to be placed at the base of a w
resized to the wall’s thickness. However a window needs to be placed a certain height fr
ground, and will be resized to the wall’s thickness. Interiors also needs to be told not to
the wall over the top of the model. All this information is supplied within Modeler, allow
Interiors to easily add the model from a library or file.

Firstly start by completing or opening a model of a window or a door. Change view t
Home view (Command + 3) to have a clear view of the model.
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For the purpose of visual aid a door will be used to highlight the process, but equally a w
can be used. For the model that has been produced make sure that everything is prese
the right position, i.e. window panes, door handles, etc. 

Now group the door and make it a primitive if not already. Now open the Construct p
from the Palettes menu and with the new door selected, check that it has no assignatio
ing the modeling of the door if some construction or intersections have been performed
loose assign A or B may still be attached. When objects are grouped the assignments 
but if one object has an assigned value and the other does not, an A or B can still be as
It is always a good idea to check.

At this point open the Info palette and with the door still selected make a note of the d
sions of the door, these will be needed shortly.

Select the Cube tool from the Tools menu and draw out a simple rectangle on the grid 
distance from the door. Once this is drawn re-enter the Info palette and change its dimen
be that of the door (which were noted down earlier). This new block will be used to m
precise cut out of the door into which it can fit and be placed in the wall. Check the wid
the original door and in the Info palette make the new block just 10 mm thicker.
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This will ensure that the handles and everything are caught by the cut out block. It is imp
to note at this stage that no matter how wide the walls are made this new block (the 
block) will always resize itself (in terms of width) to accommodate this. This is due to
physical properties that will be changed to let the program understand that this is a d
previously discussed. Now go back and select the original door and note down its posi
terms of X, Y and Z. Now select the block that has just been made and in the Info palett
the previously noted positions for the door.
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This is just a quick method of getting both the door and cut out block in exactly the same
tion. The block could easily be moved and position with the aid of Snapping but this w
much quicker. Once this new block is in position the door should no longer be visible. S
the block (if not already selected) and open the Construct palette. Assign this new block
in the Info palette move the Transparency slider all the way to the right so it is only visib
its bounding box.

Now the door will be visible again. Note that if no door was present then only a cut ou
would exist as an object. Even though it is colorless if saved in a library and then reope
Microspot Interiors it could be used as an open door way. Now drag a box over the d
select both the cut out and the door. Once both are selected group them together usin
under the Edit menu or via the shortcut Command + G. With the new group still selected
the Options menu select Primitive. Note that the entire group is now classified as an as
Now from the Palettes menu open the Item tag palette.
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This palette simply assigns a value for either a door or a window so that the program 
what to do when one is placed in a wall. Just as with the Construct palette this works by 
an object or group highlighted and then selecting either one, or it can be unassigned by
ing None. With the door selected click the Door button on the palette. Similarly if it is a 
dow then assign it Window. Now the door is tagged. It has had a value assigned to it so 
matter what wall it is dragged on to, it will act accordingly. Cutting out the wall placing
door equally in the space or frame and allowing only movement along the floor and p
tional resizing. As with a window once this tag is placed then the window can be placed
any wall and will be able to move around on that wall and can be resized also. For th
door to be used in Interiors it must be transferred from Modeler. This is easily done 
Libraries that can be filled with any number of models. Open the Libraries plug-in from
Palettes menu.
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Select File and New. This will bring up a dialogue screen asking for a destination for thi
library. Select a suitable place to save this to, like the Home directory or Desktop, and n
something appropriate.

Click OK and this will bring you back to the Libraries palette with a blank library open. C
the display menu and note that the new library just created is at the bottom of this list.
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Position the Libraries palette so the modeling window can also be seen. Select the ne
and physically drag it into the library. A small icon will appear of this door. This can the
dragged out to make as many doors in the scene as desired. This can be done for any
or door that is produced.

Once the door is in the new library under the file menu in the Libraries palette select 
This can be opened again at any time but the same library can not be shared by two a
tions. Meaning that if Microspot Modeler and Microspot Interiors are open at the same
they can not both access newly created libraries simultaneously. Either close Modeler (m
sure the new door is saved before doing so or hide the application by either the Modele
and selecting Hide or by the shortcut Command + H). Now open Microspot Interiors.
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Either open a previously modeled room to place the door into or simply use the new doc
created to test this door. For this tutorial two walls will be drawn to test the door. Firstl
newly created library must be opened. From the Palettes menu select the Libraries pa
the Libraries palette select Open from the File menu. Now select the library from the lo
it was saved in and click OK. Now the library is open, from the Display menu select this
library containing the door from the bottom of the list.
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Now go back to the modeling window and from the Tools menu select the 
tool.

This will instantly change to the top view. Position the cursor on the bottom 
hand side of the grid and click to start a wall. Move the cursor up and click.
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This will bring up the wall options screen, the length of the walls is not important but mak
width 100 mm and the wall height 3000 mm.

Click OK and move to the left and click again, this will bring up the options window for
last time. Click Done to finish the wall as the setting will be preserved from the pre
instance. The view will now change back to the Home view with a corner wall in-front o
camera. Use the Navicam to zoom out and gain a suitable viewing position.
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Drag the new door from the library onto either wall surface and the door will appear posit
on the grid in the wall.
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ANIMATION TUTORIAL

υ Introduction

The following tutorial will show you how to operate the basic functions in Microspot Mod
to create Animations. In this tutorial you will learn how to animate movement of objects, 
era angles and lights. You will also learn how to export your animation into a QuickTime 
movie to view or share. We will create an animation of a barbeque opening to reveal a gl
heat underneath the grill as the sun sets over the scenery.

υ Creating the Scenery

Double-click on the Modeler icon to launch this application. A new untitled document wil
appear along with the Tools, Help and Info palette:
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Begin by changing the grid size to 8 grid squares at 500mm each. We will first create the
where the barbeque animation will take place. Select Base Plate from the Plug-ins menu
Menu Bar:

You have now inserted a solid floor for the scene which we can add a texture or colour to
the Libraries palette. From the Libraries palette, open the Tutorial library. Drag the Gras
ture and drop it on the Base Plate you have recently added. The texture will appear to b
torted as it is stretched across the plate, we can adjust texture by opening the Texture p
from the Palettes menu, on the Menu bar.
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Making sure the Horizontal and Vertical sliders are both locked (symbolised by a cross o
right), drag one of the sliders up to approximately 4. For a more accurate method, you ca
4 inside either of the Horizontal or Vertical value field, or hold the shift key while dragging
slider.

Once you are satisfied with the size of the texture on the base plate, we can now create
path where the barbeque will sit. By selecting the Cube Tool from the Tools palette, crea
rectangular object by initially clicking (and holding) on top of the base plate and drag up
wards.
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Edit the dimensions of the object using the Info palette to the following sizes:

Click on the Gravity tool and then on the object to ensure it is directly on top of the base

We can now lock the Y-position of the cube, to be able to reposition it without accidentall
ing it off the ground. Click on the Y-position padlock on the Info palette so that the padlo
symbol becomes locked:
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Select Top in Change View in the View menu. Click on the shape then select duplicate fro
Edit menu. Using the nudge tool rotate the duplicated shape 90˚ and position the two obj
create a ‘T’ shaped area similar to the screen shot below.

When you are satisfied with the positions of the objects, select both and chose group fro
Edit menu. You can now drag and drop the Outdoor Tarmac texture from the Tutorial libr
onto the group. And set a scale value of 4.0 on the texture palette to make the texture loo
realistic.

Before we continue any further with the tutorial, it’s a good idea to save the document wi
title ’BBQ animation’.
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υ Animation Palettes

Open the following palettes from the Palettes menu:

Animation Player palette

This palette enables you to control the animation playing speed as well as set the anima
playtime. You can also choose to set the animation to play in cyclic mode or in oscillate 

Note: To fully open all the options on this palette, you need to click on the green button t
maximise the palette.

Animation Tweener palette

The Animation Tweener palette displays all added objects, the camera, and light animat
that have been added to a document. The Tween Increment Time value determines the t
ference between each tween added, this may be varied for each animation.

Tween Increment 
Time value
2-100



w-
 anima-

 and 

glow a 
al dif-
nents. 
The Animation Tweener palette displays a time line signified by starting and ending arro
heads. Click and drag the End arrowhead to the 10 seconds time mark. This has set the
tion time to run for 10 seconds:

υ Animating Objects

With the Library palette open, bring up the Tutorial library and select the Barbeque. Drag
drop the Barbeque onto the pavement created in the previous chapter.

Our aim is to animate the lid of the barbeque opening, and have point lights animated to 
brighter red, as the control knobs of the barbeque turn higher. In order to animate sever
ferent parts of an object separately we need to break down the barbeque into its compo
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Animating the Barbeque Lid

By Option double clicking on the Barbeque or by using the Menu commands (Options - 
mantleable and then Edit Group), a new sub document window will open with the barbe
broken down into its components.

Click anywhere on the grid to be able to select the Barbeque lid and go to the Animation
Tweener palette and type 5 into the Tween Increment Time field. Now click once on  +ob
button on the Animation Tweener palette, you will notice the lid’s original position has no
been recorded into the timeline:
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We must now record the position of the lid at its final open position. Change to the Right 
and using the Nudge palette, rotate the lid 45˚ counter clockwise.

Now using the Nudge Palette again, nudge the lid upward 175, the lid should now look a
though it is on a hinge attached to the body of the barbeque:

Click once again on the +object button, you will notice its final position is now recorded a
5 seconds mark. This means that from the first until the second tween points, the lid will
animated opening.
2-103



utton 

anima-
ntrol 

ation 
, you 
with 
To see the animation created so far click the Rewind button and then the Play Forward b
on the Animation Tweener or the Animation Player palette:

Animating the Barbeque Control Knobs

We can now animate the turning of the control knobs in the same time frame as the first 
tion. After returning to Home View, adjust the NaviCam so you have a close up of the co
knobs on the front of the barbeque:

Before we begin adding the objects positions into the Animation Tweener, reset the anim
to the start. We will have the control knobs start to turn at the beginning of the animation
can however have the animation of a particular object start and end at any specific time 
the use of the Animation Tweener.
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This time we will have the animation of the control knobs run for the first 4 seconds:

Select one of the control knobs and click once on the +object button. This will record the
position of the knob at 0 seconds, and the timeline should now be at the 4 second mark
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We can now indicate the final position we want the knob to turn to at the 4 second mark
the same knob selected use the nudge tool to rotate it 150˚ clockwise. Once the knob ap
be turned towards a higher temperature mark, click once again on the +object button.

Repeat the same process to create an animation for the second knob, remember to rew
animation back to 0 seconds before recording the first position of the second knob.

υ Animating Lights 

Animating Point Lights

To create a glowing effect of the heat underneath the grill we need to insert point lights a
position them under the grill of the barbeque. 
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Select the Point light tool from the Tools palette and forward the animation time on the A
tion Tweener or Animation Player palette until the barbeque lid is open and click on top o
grill to place the point light:

Before we correctly position the point light, change the colour of the light, using the Info 
ette, to a red:

Reset the Animation timer to 2 seconds and nudge the point light, downwards 60mm, so
is hidden underneath the grill of the barbeque. In this case, rather than animating the po
of the light, we will animate the brightness of the light, as the control knobs on the barbe
turn. To begin with we will have the light with minimum brightness:
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With the point light still selected, click on +object button to record its initial brightness.
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The time line should now be at 6 seconds, increase the brightness of the point light and
once again on the +object button.

You have now created all three animations involving the barbeque. Now close the sub d
ment window to return to the original window where the barbeque should be standing on
scenery created earlier.

You can view the animation so far by clicking on the Rewind and then the Play Forward b
on the Animation Tweener, or Animation Player palette.

Save the document.

Animating Sun Light

To create the effect of the sun setting, we can animate the movement of the sun by reco
several positions across the grid to move in. The sunlight is always set to point towards 
centre of the grid.
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Holding the Option key down, click on the Sun Direction tool in the Tools menu:

Keep the angle clockwise from North at 135˚ and change the elevation angle to 20˚ and
OK. The top view of the grid will now illustrate the position of the sun and its direction.

Go back to Home View. 
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Before clicking on +sun button to record the suns initial position at time 0 seconds, chan
Tweener Increment Time value to 9 seconds and change the colour of the sun in the Lig
ette to a pale yellow.

The timeline should now be at 9 seconds, where we can record the final position and an
the sun that it will move to. Using the Sun Direction tool again, enter 315 for the angle c
wise from North, and an elevation angle of 10˚. Change the colour of the sunlight to a da
before recording the new position of the sun in the Animation Tweener palette at 9 seco
Now click on +sun button once again:
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Animating Ambient Light 

To add a more realistic effect to the sunrise and sunset, we can animate the ambient lig
start out dark. When the sun is at a 90˚ elevation the ambient light will increase and then
again as the angle of the sun drops.

To do this we need to record three different levels ambient brightness using the Lights p
Rewind the timeline back to 0 seconds and set the Tween Increment Time value to 5, se
ambient light to a low level of brightness:

Click on the +ambient button, once the timeline moves to 5 seconds; increase the ambia
brightness and click on +ambient button again. Finally as the timeline moves to 10 seco
decrease the brightness back to a minimum and click on +ambient button once again. T
tweener should now have three tweens for the ambient light animation:
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υ Animating Camera

We can now create an animation individually for the camera movement. Rewind the anim
to time 0 seconds and adjust the NaviCam so you have a close up of the barbeque grill:

Change the Tween Increment Time to 5, and then click on the +camera button. This will r
the first position of the camera view into a tween at time 0 seconds.:
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We can now adjust the final position of the camera view using the NaviCam once again:

Click on the +camera button once again. We have now finished creating this barbeque a
tion scene. You can view the full animation by rewinding the animation back to time 0 sec
and clicking on the Play Forward button.

Save the document.

υ Exporting a Movie

Once you are satisfied with the animation, you can export the animation as a QuickTime
movie. The movie will be exported with the current renderer options settings. For higher
ity graphics use the Microspot Renderer. The higher the Microspot Renderer settings ar
the longer the movie will take to export, in this case we will export using Microspot Previ
Renderer.

Note: A large Document window size will affect the size of the movie and time to export.
recommend editing the Window Size in the Options menu to 600x480.
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You can now select the Microspot Preview Renderer from the Renderer pop-up menu in
Renderer Options palette:

As the scene begins to render, select Export Movie from the Animation menu:

The standard save dialog will then open for you to allocate where you want the file to be
and what name it should have. Once you have clicked Save a status window will appear
few moments to inform you on the expected time remaining to export the movie to file.
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υ Summary

This tutorial has shown you how to use the basic tools to create an animation. A QuickT
video of this animation is available, in the Microspot Modeler package, to compare with 
animation. There are many more options and combinations of animations you can use o
you have become familiar with the essential animation functions as shown above.
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Chapter 3

Menus

Details of the application’s File, Edit, View, Options, Palettes, Plug-in, Ani-
mation and Help menus. Command key shortcuts can be used to perform
many menu commands. See Appendix L — Command Key Table on page L-1
for details.
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 MODELER MENU

Click on the word Modeler at the top left of the screen to display the Modeler menu. The
three items relate to Modeler:

υ About Modeler 

Select About Modeler to display the About Modeler dialog. This provides information abo
the version of the application you are running, registration and serial number details.
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υ About Plug-ins

Select About Plug-ins and hold down the mouse button to display the list of the plug-ins
are currently running:
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Select a plug-in name from the list to display a dialog containing brief details about the p
in.

υ Preferences

Select Preferences to display the Preferences dialog:
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Colors

To change color preferences, click on a color square to display the Color Picker. Select 
color and close the Color Picker.

• Handle Color: The color of the handles on the bounding frame of a selected object.

• Open Handle Color: The color of the handles on the bounding frame of a group of obje
when an Editing or Group window is open, and the color of the active handle when a
object is being resized.

• Locked Handle Color: The color of the handles on the bounding frame of a locked obje

• Light Marker Color: The color of the cone or point marking the position of a Spot/Point
Light. If this color is set to white, the color of each light marker will be the same as t
color of the light.

• Grid Color: The color of the grid.

• Background Color: The color displayed in the background of a new file.

• Default Color: This is the color that displays in the color block in the window toolbar an
used to draw new objects.

• World X, Y, Z Color: The colors that are used to draw the respective axis.

• Object X,Y,Z Color: The colors that are used to draw the lines of the bounding frame o
object.

Default Tool

Choose either the Arrow or Rotate Tool as the default tool.

Options

• High Resolution Printing: Click to print at printer resolution rather than screen resolutio

• Sound On: Click to play sounds within the application.

• Dynamic Updates: If this option is enabled, all open windows for a particular documen
will automatically be updated as objects are created or manipulated in the active win
and as slider bar controls in palettes are changed. If this option is not enabled, only
active window will be updated as actions are performed. Other open windows will no
updated until the action is complete and when moving slider controls, views will not 
updated until the mouse is released.
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• Solid Grid: Click to specify that the document grid should appear as a solid floor rath
than a wire frame grid.

• Global Lights: When this check box is enabled, the controls in the Lights palette relate
the document. When it is not enabled, the controls in the Lights palette relate to the 
window only.

• Advanced Handles: When this option is checked on, the lines of the bounding frame of
object can be clicked on and dragged to resize the object.

• Auto Show Plug-in Palettes: When this option is checked on, whenever a plug-in tool is 
selected in the Tools palette, any plug-in palettes that are associated are opened.

• Auto Hide Plug-in Palettes: When this option is checked on, whenever a plug-in tool is 
selected in the Tools palette, any plug-in palettes currently open are closed. This he
prevent your work space from becoming too cluttered.

• Do Undos: The Do Undos checkbox is used to specify whether or not you wish to be 
to use the Undo command. It is checked on by default.

• Display X, Y, Z World Axis: These options enable the display of the world axis that are 
drawn with the origin in the center of the grid.

• Edges to a Circle: Enter a value for the number of sides a circle should have. This will af
the appearance of circles, spheres, cylinders, etc. The lower the value, the coarser 
curve. The higher the value, the more memory and disk space you will need to displa
store the images. The default value is 24.

Note: In version 3.6 Dynamic Tesselation has been added so that objects viewed in the 
ground will have the full number of edges but items in the background will have progress
less. This enables faster rendering of objects as they become less obvious in the scene

υ Quit

Quits the application and closes all open files and their associated windows. If any open
have been changed without being saved, a dialog will display asking if you wish to save
changes.
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FILE MENU

υ New

Creates a new, untitled document.

If there is a document called Default Stationery Pad located in the same folder as the ap
tion, a copy of this document will be opened as an untitled document (a document is tag
a stationery pad via the Get Info dialog). This allows you to use the same customized se
for each document.

υ Open

Opens an existing Modeler file, or any other file created by a 3DMF-compatible applicat
(Such as Microspot Interiors or Microspot Modeler).
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υ Insert

Select Insert to input 3DMF or picture files into the documents.

When the standard dialog displays, select a file to insert. The Insert Dialog will display:

The options available will depend upon the type of file selected, and whether an object w
selected when Insert was chosen. The type of file selected will be indicated on the right s
the dialog.

Add as Object

The selected file appears either in the center of the grid or at the last place the mouse w
clicked.

• 3DMF file: Appears as a 3D object, the orientation of which will depend on the informa
contained in the 3DMF file.
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• Picture file: The image displays as a rectangle with the same proportions as the origin
picture. The longest side of the rectangle is equivalent to the length of one side of on
square and its orientation relates to the grid.

Add to Object

This option is only available if an object was selected in the document before Insert was
sen. The file is converted to a picture (if necessary) and applied to the selected object a
ture. The properties of the selected object will determine how it is applied.

Fore/Background Picture

The file is converted to a picture (if necessary) and placed in the foreground/background
it remains even if the view changes. If the proportions of the image are not the same as t
portions of the window, the image is distorted to fit the window. Its size remains constan
tive to the window size.
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υ Import

The Import submenu allows you to access Import options. See Appendix A — Appendix A on
page A-1 for more details.

υ Export

The Export submenu allows you to access Export options. See Appendix B — Appendix B on
page B-1 for more details.

υ Close

Closes the current document and its associated windows. If the document has not been
or if changes have been made to it since it was last saved, an alert will display asking if 
want to save the document before closing.
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υ Save

The Save option is only available if a document has never been saved, or if changes hav
made to it since it was last saved. Using the Save option saves the document in 3D meta
mat. If the document has not been saved before, a dialog will display for you to specify t
document name and a location to save it.

To save a document as a stationery pad, give it the name Default Stationery Pad. The do
will be automatically tagged as a stationery pad. 

υ Save As

Choose to save a document (in 3D metafile format) under a different name or in a differe
location. If you try to save a document in the same location as a document of the same 
an alert will ask if you wish to replace the existing file.

υ Revert

Returns to the last saved version of a document. (This option will only be available if the
ument has been previously saved.) An alert will display to ask if you are sure you wish to
revert.

υ Page Setup

Select to display the Page Setup dialog. The options available in the Page Setup dialog
depend on the printer driver you have selected in the Printer Setup Utility.
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υ Print

Select to display the Print dialog. The options available in the Print dialog will depend on
printer driver you have selected in the Printer Setup Utility.

EDIT MENU

υ Undo

Allows you to undo your last object manipulation. Selections, de-selections, mode chang
and view changes are not object manipulations, and therefore cannot be undone.
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This option will be disabled if no document is open, if an open document has not been ch
since it was last saved, or if Do Undos has been turned off in the Preferences dialog. See 
Options on page 3-6 for further details.

After an object manipulation has been undone, the Undo option will change to Redo. Se
Redo to perform the action again.

υ Cut

Removes a selected item from the current document and places it on the clipboard whe
remains until replaced by another item cut or copied from the document.

υ Copy

Copies a selected item from the current document and places it on the clipboard where 
remains until replaced by another item cut or copied from the document.

υ Paste

Pastes items into the current file either in the center of the grid or at the last place the m
was clicked. 3DMF or PIC files can be pasted into Modeler documents. 3DMF data are p
in as 3D objects and PICT files are pasted in as rectangles.
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υ Paste Special

Paste Special is only available if you have cut or copied items from an application other 
Modeler. When you select Paste Special, the following dialog displays:

Items cut or copied from other applications can be placed in  Modeler documents in a va
of ways, depending on their formats. 

The Paste Special options available to you will depend on the type of file selected, and w
an object was selected prior to choosing Paste Special.

Add as Object

The file will appear either in the center of the grid or at the last place the mouse was clic

• 3D Object: Appears as a 3DMF, the orientation of which depends on the information c
tained in the 3D object file.
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• Picture: The image displays as a rectangle with the same proportions as the original 
ture. The longest side of the rectangle is equivalent to the length of one side of one 
square, and its orientation relates to the grid.

Add to Object

This option is only available if an object was selected in the document prior to choosing 
Special.

Available for:

• 3D object: The file is converted to a picture and applied to the selected object as a tex
The properties of the selected object will determine how it is applied.

• Picture: The file is applied to the selected object as a texture. The properties of the se
object will determine how it is applied.

Fore/Background Picture

The file is converted to a picture (if necessary) and displayed in the document foregroun
background where it remains even if the view changes. If the proportions of the image a
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the same as the proportions of the window, the image is distorted to fit the window. Its s
remains constant, relative to the window size.

Available for:

• 3D object

• Picture

υ Delete

Use the Delete command to remove items or attributes. The six options in the top part o
popup menu are only available if an item is selected within the document before Delete 
sen.
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 An entire object can also be deleted from a file by dragging and dropping it into the tras

The last three options in the Delete menu allow you to remove the document’s backgrou
color, background picture and foreground picture.

υ Select All

Selects all of the objects in the current window.

υ Select None

Deselects all of the selected items in the current window.

υ Duplicate and Clone

The Duplicate and Clone operations appear identical, however, when an object is duplic
the duplicate is created as an entirely separate item and is unrelated to the original. Wh
object is cloned, the clones share the same basic geometry and surface attributes as th
nal. This means that if the geometry, color, transparency etc. of the original is changed, 
clones will also be changed, and if a clone is changed, other clones and the original will
changed. The link relates to the basic geometry and surface attributes only. Changes in
position and rotation will not be reflected by the clones.

The Clone command can be very useful in certain situations as due to their shared attrib
clones use less memory than duplicates, and changes can be made quickly to several c
objects at once.
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1. Select an item or group of items and choose Duplicate/Clone.

2. A duplicate/clone of the selected item or group of items is placed one grid square 
right of the original:

3. Move the duplicate/clone and choose Duplicate/Clone again.
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4. The second duplicate/clone will be positioned in the same position relative to the 
duplicate/clone, as the first duplicate/clone was to the original:

Any rotations that are applied after the first duplication are also applied to subsequent d
cated items. This is useful for drawing items like spiral staircases.

Hold down the Shift key when using the Duplicate/Clone option to avoid applying any of

υ Group

Groups two or more objects and allows them to be manipulated as a single object.

1. Select the desired items, then choose Group. Grouped items will be surrounded b
bounding rectangle or sphere depending on whether the arrow or rotate tool was u
select them:
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2. Double-click on the group or choose Edit Group from the Options menu to open a
window containing only the items within the group:

3. Manipulate these items individually, then close the window to view your changes in
original document:

While a Group window is open, the handles of the bounding rectangle or sphere around
original grouped items will change color. This indicates that the objects are selected, an
Group window is open. The color of the handles is set in the Preferences dialog. See Colors on 
page 3-6 for further details.

If the grouped objects have been placed in further groups, the Group window will contai
grouped objects. Double-clicking on these groups will open additional windows showing
contents of their respective groups.

If a group of objects is flagged as Primitive, it is not possible to edit the items within the g
by double-clicking on the group or choosing Edit Item from the Options menu. The grou
must be flagged as Dismantleable before the individual items can be edited. 
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υ Ungroup

Un-groups selected items so that members of a group can be selected individually. Note
this option only un-groups one level at a time.

If a group is flagged as Primitive, the Ungroup option will be grayed out in the Edit menu
will not be selectable. The group must be flagged as Dismantleable before it can be un-
grouped.

VIEW MENU

υ New Window

Opens a new window for the current document. The new window displays the same view
the original window, and is offset from it. 
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υ Close Window

Closes the current window. If this is the last open window for a document, the document
also be closed. 

υ Name View

Saves the current view. Enter a name for the view in the dialog that displays:

You cannot use the names of the standard views included in the program. If you specify a
that has already been used to save a nonstandard view, an alert displays asking if you w
name your view.

υ Delete View

Deletes a saved view. This option is only available when new views have been created a
saved (standard program views cannot be deleted).
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1. Select Delete View and a submenu lists the views that may be deleted:

2. Select the name of the view to delete from the submenu and the view will be dele

3. If you do not select a view from the submenu, the delete view dialog displays sho
the views that can be deleted

4. Select the view to delete and click OK.

Note: If a document window was displaying a view that has now been deleted, the window
remain open as an untitled view.
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υ Change View

Click on Change View to display a popup menu which lists the available views (including
that you have saved). The view in the current window will be indicated by a check mark. M
the cursor down the list to select the desired view:

The current window will change to reflect your choice. If a standard view has been chan
hold down the Option key and select the name of the standard view to reset it to the def
standard view.

The view displayed can also be changed via the Command key shortcuts shown in the C
View popup menu above, or through the popup menu in the Window controls. See View on 
page 4-33 for further details..
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Look at Selected

Displays a selected object in the center of the window:

Home View

Returns the camera to its initial position (the view displayed when a new file is opened):

Custom

Any nonstandard view, or any view that has not been saved is a Custom view.
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Plan, Top, Front, Left, Right and Back

The six standard views that allow you to display the file from the sides, top and a plan vi

Last View

The view that was displayed in the window immediately prior to the current view.

υ Open Documents

At the bottom of the view menu is a list of the documents and views that are currently op
The active window has a check mark to the left of its name. Documents that have been ch
since they were saved are underlined. Select a document/window name from the list to m
the active window:

Plan

Top

Left Right

Front Back
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OPTIONS MENU

υ Edit Group

Select to edit individual objects within a group.
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Double-click on the group, or select the group and choose Edit Group from the Options m
to display a new window which contains only the items in the group.

The items can now be edited individually. As you edit the individual items, the group rem
locked in the original file window, although it will be updated to reflect any changes you m

Hold down the Option key when closing an editing window, and all editing windows for th
file will be closed.

Items and groups can be flagged as Primitive or Dismantleable. If the selected group ha
flagged as Primitive, Edit Group will be grayed out and will not be selectable. Flag the g
as Dismantleable to edit it. 
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υ Lock

Protects a selected object or group from being changed. A locked object can be groupe
other objects, but cannot be moved, resized or changed. If you group a locked object with
objects, the entire group will be locked.

If you place the cursor over a locked object, a padlock displays next to it.

An object or group can also be locked by selecting it and clicking on the large open pad
icon in the top right corner of the Info Palette. See Lock on page 4-18 for further details. 

υ Unlock

Select a locked object or group and choose Unlock to remove the protection against cha
An object or group can also be unlocked by selecting it and clicking on the large closed 
lock icon in the top right corner of the Info Palette. See Lock on page 4-18 for further details

υ Primitive

Specifies that an item or group should be treated as a basic geometry. A basic geometry
be un-grouped, so individual surfaces or items cannot be edited. 

υ Dismantleable

Specify that an item or group can be broken down into its component parts. This will allow
to ungroup an item or items and edit individual components as separate items. 
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υ Grid Snap

Grid Snap applies an invisible grid to the document to which object points can snap. It is
enabled by default to make it easier to align objects. The distances between the nodes 
grid are determined by the value entered for the Snapping Grid Distance in the Grid Opt
dialog.

When Grid Snap is enabled and a new item is drawn, the cursor is positioned on the clo
snapping grid intersection. As the object is drawn, the object’s handles snap to the snap
grid’s intersection points. As an object is resized, the object’s handles are positioned on 
ping grid intersection points. When an item is moved, its center point will snap to the sna
grid intersection points.

If Grid Snap was disabled when an object was randomly positioned in the file, the item w
moved or resized in increments of the snapping grid distance when Grid Snap is enable

Reselect the Grid Snap option in the Options menu to turn this option off.

υ Grid Options

Choose Grid Options to display the Grid Options dialog:
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• Solid grid: When this check box is enabled the documents grid will appear as a solid 
rather than a wire frame.

• Number of grid squares: This value relates to the visible grid. Enter a value to specify th
number of grid squares that should make up one side of the grid.

• Grid square size: This value relates to the visible grid. Enter a value to specify the lengt
one side of one grid square.

• Snapping grid distance: This value defines the invisible snapping grid. Enter a value for
length of one side of one snapping grid square. Typically, you will want to give the s
ping grid distance a value that is a fraction or multiple of one document grid square.

• Preferred unit size: This option allows you to select a unit size.

The entries in the popup menu are determined by whether metric or inches has bee
selected in the Options menu as discussed below.

υ Metric

Select this option to use metric units of measurement. The grid size, position coordinate
dimensions will all be calculated using metric units. 

υ Inches 

Select this option to use inches, feet or yards as the units of measurement. The grid siz
tion coordinates and dimensions will all be calculated using inches, feet or yards.
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υ Window Size

Set the size of the current drawing window in screen dimensions.

Note: Pixels are a measure of dot on screen, with a pixel representing a single dot.  

υ Orbit Around View

Select Orbit Around View to rotate the camera around the point at the center of the curre
view. Click anywhere in the window to stop the rotation.
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PALETTES MENU

Click on Palettes in the application menu bar to display a list of available palettes.  Selec
palette name from the list to open it.

When a palette is currently open, a tick will appear next to it in the palette menu. If it has
docked with another tab, but is currently not visible, a diamond will appear next to it in th
menu.

See Chapter 4 — Tools Palette on page 4-4 for details of the Tools, Info and Help palette
Appendix D — Plug-in Palettes on page D-1 for details of plug-in palettes.
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PLUG-IN MENU

Click on Plug-ins in the application menu bar to display a list of available plug-ins. 

Select the plug-in name from the list to open it.

See Appendix C — for details of the plug-ins accessed from the Plug-ins menu.

ANIMATION MENU

Click on Animation in the application menu bar to display a list of animation plug-ins.

Select the animation plug-in name from the list to open it.

See Appendix C — for details of the plug-ins accessed from the Plug-ins menu.
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HELP MENU

υ Modeler Manual

Select this option to launch and display the Microspot Modeler User Guide.

υ Microspot Library Download

Select Microspot Library Download to go to the Microspot Download web page to downl
the latest libraries and updates.

υ Registration Information

Select Registration Information to register your product via the Microspot web page. The
ister Information dialog displays:

Click on the Connect button in the dialog to go to the web page.
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υ Upgrade Information

Select Upgrade Information to obtain product upgrade information (if any) from the Micro
web page. The Upgrade Information dialog displays:

Click on the Connect button in the dialog to go to the web page or alternatively, contact 
Microspot via telephone, fax or email for upgrade information.
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Chapter 4

Palettes

The Tools, Info and Help palettes are the standard palettes included in the
application. All other palettes are plug-in palettes that are loaded when the
application is launched. 
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INTRODUCTION

To open a palette, select its name from the Palettes menu. The Palettes menu lists of al
available palettes.

The status and position of palettes is remembered each time the application is closed. C
palette by clicking on the top left corner of the palette window.
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Tools Palette

The tools built-in to the application Tools palette are the Arrow, Rotate, Rectangular Mar
and Hand tools.

The rest of the tools are plug-ins that are loaded when the application is launched 

Select the tool to use by clicking on its icon in the Tools palette. After a tool has been use
currently selected tool reverts to being the Arrow tool, unless the default tool is changed 
Preferences dialog. See Preferences on page 3-5 for further details. You can, however, double-
click on any tool to lock it in so that it will not change after you use it, but will remain sele

υ Select/Move

Both the Arrow and Rotation tools can be used for selecting and moving objects. You ca
click and drag on the grid with either tool to move the entire scene in the window. 

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized. 

Select

When an object is selected, it is surrounded by a bounding frame with handles at the po
where the bounding lines intersect:

Arrow (a)

Rectangular Marquee (m)

Rotate (r)

Hand (h)
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To temporarily hide an object’s bounding frame, hold down the Option key and click on t
arrow or rotate tool. The item is still selected, but the bounding frame and handles do no
play. To re-display, click on the arrow or rotate tool again.

To add objects to a selection, hold down the Shift key and click on the additional objects
deselect one object in a selection, hold down the Shift key and click on the object. If you
on an object that is part of a group, the entire group will be selected and the bounding fr
will surround all of the items in the group. 

Double-click on a group of objects to open a new window in which the grouped items ca
edited:
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When you close this editing window, any changes you have made will be reflected in the
nal document window. You can also edit a group by selecting it and choosing Edit Item f
the Options menu. See Edit Group on page 3-28 for further details.

Hold down the Command key and click the mouse to select an object that is behind ano
object. Initially, the foremost object will be selected. The second time you click the mouse
next object back will be selected, and so on:

Move

To move an object, click on it, hold down the mouse button, and drag. Release the mous
ton to place the object in its new location. Hold down the Control key and drag up or dow
move the object closer or further away. If you hold down the Shift key, lines will display s
ing the X, Y and Z axes, and movement will be constrained to these axes:
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Objects can also be moved by entering coordinate values in the Info Palette. 

υ Select/Move/Scale

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized.

Select an object with the Arrow tool, it will display surrounded by a bounding frame with 
dles at the corners.

As an alternative to clicking and dragging, you can move an object using the arrow keys
selecting the object and pressing the desired arrow key to move it one pixel. If you hold 
the arrow key, the object will move one pixel at a time until it has moved six pixels. It will t
begin to move at an accelerated rate. To move objects closer or further away, hold down
Control key while using the up and down arrow keys.

To change the size of an object, move the cursor over one of the handles of the boundin
frame. When the cursor changes to a white arrow, click the mouse and drag. The shape
of the object will change to reflect your actions:

Note: If the Advanced Handles preference is checked on in the Preferences dialog, the li
the bounding frame of an object can also be clicked on and dragged to resize the object
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Hold down the Shift key when resizing an object to constrain movement to the X, Y, or Z
or to maintain the objects proportions. Four constraining lines are displayed. The red lin
resents the X-axis; the green line the Y-axis; and the blue line the Z-axis. The pink line re
sents the line along which the object will retain its current proportions: 

If, after resizing the object, you hold down the Option and Shift keys and resize the obje
second time, the pink line will move to a position which allows you to constrain the objec
the proportions it was originally drawn with:

Objects can also be resized via the controls in the Info Palette. 
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υ Select/Move/Rotate

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized. 

When an object is selected with the Rotate tool, it displays surrounded by a bounding sp
with six handles.

To rotate the object, move the cursor over one of the widgets of the bounding frame. Wh
cursor changes to a white arrow, click the mouse and drag. The object will rotate to reflec
actions:

Note: holding down the Shift key while rotating an object using the handles, constrains th
rotation to 90°.

To rotate the object, in one axis only, move the cursor over one of the lines of the bound
frame. When the cursor changes to a white arrow, pointing right, click the mouse and dra
object will rotate to reflect your actions in one axis only:
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Note: holding down the Shift key while rotating an object using the rotation rings, constra
the rotation to 45°.

You can also use the arrow keys to rotate objects. If you hold down the arrow key, the ob
will rotate in 1° increments for 6°, then accelerate to 10° steps. If you hold down the Shif
while using the arrow keys, you can rotate objects in 45° increments. To tilt an object, ho
down the Control key and use the left and right arrow keys.

The arrow keys can also be used to move and rotate the camera when nothing is selecte
document window. The camera will either move or rotate depending on which tool is curr
selected. Use the control key to move the camera in the Z dimension.

υ Manipulating The Grid

The Arrow and Rotate tools can be used to move and rotate the grid, as well as objects,
ily manipulate your view of a document.

Moving The Grid

Select the Arrow tool and move the cursor over the grid. Hold down the mouse button, th
sor changes to an open hand. Move the cursor up, down, left or right. The grid will move
reflect your actions:
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Hold down the Control key and move the mouse up and down to move the grid closer an
ther away:
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Hold down the Shift key when moving the grid to display, and constrain movement to, the
and Z axes:

Additionally, you can hold down the command key to rotate the grid, whilst the arrow too
selected:
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Rotating The Grid

Select the Rotate tool and move the cursor over the grid. Hold down the mouse button, t
sor changes to an open hand. Move the mouse up, down, left or right. The grid moves to
your actions:

Hold down the Shift key while rotating the grid to constrain it to its initial plane. It can the
only be rotated in that plane:

Holding the command key down before grabbing the grid will allow you to switch betwee
rotating or moving the grid.
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υ Rectangular Marquee 

Select the Rectangular Marquee tool, hold down the mouse and drag out a rectangle to 
one or several objects:

 Note: that if any part of an object is inside the marquee, that object will also be selected

To add objects to a selection, hold down the Shift key and drag a rectangle around the d
objects. To deselect items, hold down the Shift key and drag a rectangle around selected
You can also add or remove items from a selection by clicking on them with a Selection 
while holding down the Shift key.

υ Hand

Use the Hand tool to change the view of the document by altering the position of the cam
When you select the Hand tool, a frame will appear around the contents of the window. 
curser will change type near the corners of the frame:
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You can either position the view within the frame, or position the frame around the view. 
position the view, click outside the frame and drag the mouse. To position the frame, clic
inside the frame and drag the mouse:

If you are in an elevation or orthogonal view, move the mouse left and right to crab, or up
down to change the camera height.

If you are in a perspective or user defined view, move the mouse left and right to pan the
era, or up and down to tilt the camera. Hold down the Option key and move left and righ
crab, up and down to change the height.
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To zoom in on an object (note that you are not actually moving the camera, but rather na
ing the focus), click on one of the frame corners and drag it in towards the center of the 
dow:

When you select another tool, the window changes to show the view you have chosen:
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INFO PALETTE

The Info palette displays information about, and provides controls for you to adjust, the c
acteristics of a selected object or light.

Select Info from the Palettes menu to display the Info Palette. When it is first opened, all 
Info palette will be visible. To reduce the palette click on the button on the right in the top
corner of the palette. To extend the window, click again.

Note: The controls in the Info Palette will vary depending on whether you have selected a
object or a spot/point light in the document window:

υ Name

The Name box provides a space to enter a name for an object or group of objects. Thi
will be displayed whenever the object or group is selected.

 Lock Position

Lock Size

Lock Rotation

Constrain

Lock Object
Primitive/

Lock Reflective Color

Dismantleable Flag

Proportions

Lock Surface Color
4-17
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υ Primitive/Dismantleable

This option is only available when an item or group is selected. A Primitive item cannot b
ungrouped into component items. Click on the button to toggle between Primitive and Dis
tleable. The solid square button represents the Primitive state and the split button the Di
tleable state. An object can also be specified to be Primitive or Dismantleable by selectin
Primitive or Dismantleable from the Options menu. See Primitive on page 3-30 and Disman-
tleable on page 3-30 for further details.

υ Lock

To lock a selected object or group of objects, click on the padlock icon in the top right c
of the Info palette, or select Lock from the Options menu. See Lock on page 3-30 for furthe
details. This will prevent the object or group from being moved or changed. To unloc
object, click on the Padlock icon a second time, or select Unlock from the Options menSee
Unlock on page 3-30 for further details.

υ Position

The figures displayed in the X,Y and Z Position boxes are the grid coordinates of the cen
the selected object’s bounding rectangle. If you select items that are grouped together, t
coordinates displayed will relate to the group. If you select more than one item and the i
are not grouped, no coordinates will display. 

To precisely position an object, type in values for the X, Y and Z coordinates, then press 
The object will move to reflect your entries.
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Lock Position

The padlocks next to the position boxes are used to lock the position of an object. The lo
options work the same for groups of objects as for single objects.

Click on the padlock next to the X position coordinate. It will close, which means the obje
in a fixed position on the X axis (in relation to the grid), but can still be moved in the Y an
axes. Any or all coordinates can be constrained. If an object’s position is constrained on
three axes, it cannot be moved. However, you can still change the object’s size (unless i
also been constrained).

υ Size

The size boxes display the X,Y and Z dimensions of an object’s bounding rectangle. If y
select items that are grouped together, the dimensions displayed will relate to the group
bounding rectangle. If you select more than one item and the items are not grouped, no 
sions will display. To precisely resize an object, type in values for the X, Y and Z dimens
then press Enter. The object will be resized to reflect your entries.

Note: Information about the object’s size will be grayed out if you have selected a light as
objects have a constant size which cannot be changed.

Lock Size

The padlocks next to the size boxes are used to lock the size of an object. The lock opti
work the same for groups of objects as for single objects.

Click on the padlocks by the size dimensions to constrain an object’s size. Click on a clo
padlock to open it and un-constrain an object’s size. Any or all size dimensions can be c
strained. If all are constrained, the size cannot be changed. If just one dimension is con-
strained, you can change the other dimensions.
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Constrain Proportions

The Proportional Constrain checkbox to the bottom right of the dimension fields allows y
constrain the proportions of an object. Select an item and click on the checkbox to turn o
portional Constrain.

The item can now be resized or moved, but will always maintain its current proportions.

υ Rotation

Lock Rotation

Below the size controls are additional padlocks for the X, Y, and Z axes that are used to 
strain the rotation of an object.

Click on the padlock relating to the X axis. It will close, indicating that the object cannot 
rotated around the X axis (in relation to the grid), although it can still be rotated in the Y a
axes. The rotation of the object can be constrained in any or all of the axes. The X Y and 
are determined by the orientation of the object.

υ Transparency/Brightness

Transparency

Select an object and use the Transparency slider control to adjust its transparency.
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• When the transparency slider is to the left of the bar, the selected object is opaque:

As the slider is moved along the bar, the object becomes more transparent:
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Brightness

If a light is selected, the first slider control relates to the brightness of the light it emits:

υ Color

Surface

The Surface color box shows the color of the selected object.
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To change the color of the object, click on the Surface color box to display the Color Pic
Select a color and close the dialog. The color you have chosen will be displayed as the S
color and applied to the selected object. 

If a light is selected the Spot Light color box or Point Light color box is the color of the lig
emitted by the light object. The light marker color will also change to this color. If the ligh
marker color was changed by use of the Preferences dialog the light marker will stay the
erence color value. See Colors on page 3-6 for further details. Colors can also be dragged an
dropped onto the spot or point light color box.

Gloss

The Gloss color box shows the reflective color of the selected object. If light is shining o
object (sun light or spot/point lights), the part of the object that shines displays the gloss 
This will only be visible if you have selected the Best Shading option for the interactive r
derer, or the Microspot Renderer via the Renderer Options palette. See Renderer Options on 
page D-34 for more details. This option is not available for lights.

To change the reflective color of the object, click on the Gloss color box to display the C
Picker. Select a color and close the dialog. The color you have chosen will be displayed
Gloss color box. Colors can also be dragged and dropped onto the Gloss color box.

Lock Color

The padlock next to the color boxes is used to protect the color values of an object.
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If an object is selected, the second slider control relates to its amount of gloss or shinine
object has. Use the slider control to adjust the degree of gloss or shine you place on an 
The Matt- Gloss value is affected by the amount of directional light on an object:
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Spread

If a spot light is selected, the second slider control allows you to adjust the lens angle of
light and narrow or widen the beam. Note that this option is not available for point lights:
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Renderer Brightness

If an object is selected, the Renderer Brightness slider control allows you to adjust its refl
ity, which is the amount of ambient light the object reflects. This will only be visible if you
have selected the Microspot Renderer via the Renderer Options palette. See Renderer Options
on page D-34 for more details.:
4-26



 light. 
ion is 

s (such 
lected.
Sharpness

If a spot light is selected, the third slider control allows you to adjust the sharpness of the
Move the slider control to sharpen or un-sharpen the focus of the light. Note that this opt
not available for point lights:

υ Comments

The Comments box provides a space to enter details about an object or group of object
as a description). These comments will be displayed whenever the object or group is se
4-27
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THE HELP PALETTE

The Help palette displays coordinate values that show the position of the cursor and hel
sages or information relevant to the tool selected, cursor position or rendering status (if 
interactive renderer is being used).

Select Help from the Palettes menu to display the Help palette:

To resize the Help palette, click on the resize box in the bottom right corner of the palette
holding down the mouse button, drag to resize the palette. Release the mouse button w
palette reaches the desired size.
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WINDOW CONTROLS

The Window controls are displayed at the bottom of each window:

Selecting an option affects only that window, regardless of how many other views are op

υ Zoom Out

Use the Zoom Out button to widen the focus of the camera’s view and make objects app
be farther away. Position the cursor over the Zoom Out icon and click once to zoom out 
slightly. Click and hold the mouse button down to continue zooming out. 

υ Zoom In

Use the Zoom In button to narrow the focus of the camera’s view and make objects app
be closer. Position the cursor over the icon and click once to zoom in slightly. Click and 
the mouse button down to continue zooming in.

υ Wire Frame

Select this option to view objects in wire frame mode. Working in this mode is usually fas
than working in solid fill mode as there is less information to be updated after each chan
4-29
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υ Solid Fill

When the Solid Fill option is selected, objects are displayed with filled surfaces. Althoug
working in this mode may be slower than working in wire frame mode, it offers a better r
sentation of your 3D models.

υ Orthographic

Select the Orthographic option to see an orthogonal view of the document rather than a
spective view. In an orthogonal view, all parallel lines display as parallel.

υ Perspective

Select the Perspective option to see a perspective view of the document rather than an o
nal view. In a perspective view, parallel lines converge. 

υ Coordinate Systems

Select the Camera, World or Object icon to specify a coordinate system. The system yo
choose will affect the way new objects are drawn and existing objects are manipulated. 
the bounding rectangle of a shape is drawn according to the coordinate system, changin
shape or size of the bounding rectangle will have different effects on the object when usi
different coordinate systems.
4-30
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The grid is drawn according to the World Coordinate System. Holding down the Shift key
strains movement to the X, Y or Z axes. When moving or resizing an object, holding dow
Shift key makes the axes visible. The X-axis is red and runs left to right; the Y-axis is gree
runs top to bottom; and the Z-axis is blue and runs in/out. These constraining lines will b
different positions depending upon which coordinate system is being used.

Camera Coordinates

When this option is selected, the X, Y and Z axes relate to the direction and angle of the
era. New objects will be drawn perpendicular to the camera. Object manipulations can b
strained to the axes that relate to the camera.

World Coordinates

When this option is chosen, the X, Y and Z axes relate to the World Coordinates and are
same as the grid axes. New objects will be drawn in relation to the World Coordinate X,Y
Z axes. Manipulated objects can be constrained to these axes.

Object Coordinates

This is the default option. When the Object Coordinates option is chosen, the X, Y and Z
relate to the orientation of a selected object.

υ Radius

If Radius mode is selected, objects are drawn from a central point. This is the point at w
you first placed the cursor to start drawing an object. When resizing an object, the center
object will remain in a fixed position:
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υ Diameter

This is the default mode. When selected, objects are drawn from the point where you ini
placed the cursor and began to draw. When resizing an object, the corner opposite the o
are dragging will remain in a fixed position:

υ 2D

If 2D Mode is selected, objects can only be drawn in 2D. An object will normally be draw
the X,Y plane, however if you begin drawing while holding down the Control key, the obj
will be drawn in the X,Z plane. If you release the Control key while continuing to hold do
the mouse button, the object can be flipped into the Y,Z plane. Once drawn, the object w
constrained from resizing in the smallest axis until the constrain locked flag is turned off i
Info Palette.

υ 3D

This is the default mode which allows you to draw objects in 3D. Hold down the Control 
and move the mouse up and down to move in and out in the document space.
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υ View

Use the View popup menu to select a different view, including any view that you have sa
When you select a view option, the window will change to display your selection:

The Command key options and View menu can also be used to choose a view. See Change 
View on page 3-25 for further details.

υ Default Color

The color displayed in the color block at the bottom right of the window toolbar is the cur
rently selected color. Any new items created (except lights and markers) will automatica
this color, even if you are working in wire frame mode.

To change the default color, click on the color block and select a new color from the Col
Picker:
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To change an object’s color, click on the color block and drag the color over the object. I
be highlighted by a bounding frame to show that it is selected. Release the mouse butto
apply the color to the object. You can also select an object, then go to the Color Picker a
select a new color to automatically apply that color.

υ Window Resize

To change the size of the window you are working in, click on the Resize Window icon. H
down the mouse and drag to resize the window.
4-34
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Import Plug-ins

Import plug-ins are accessed via the Import submenu in the File menu.
Table of Contents

Introduction A-2

3ds A-2
A-1
Return to main table of contents
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υ Introduction

Open the File menu and select Import. A submenu lists the installed Import options:

υ 3ds 

The 3ds plug-in imports 3ds formatted files into an Modeler document.

1. Select 3ds from the Import submenu in the File menu.

2. Select the file to import from the dialog that displays.

3. The selected file will then be imported into the current Modeler document as a 3D
object.

4. The size of the object will depend on your current grid size.  
A-2
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Appendix B

Export Plug-ins

Export plug-ins are accessed via the Export option in the File menu.
Table of Contents

Introduction B-2

Picture B-2
B-1
Return to main table of contents
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υ Introduction

Open the file menu and select Export. A submenu lists the installed Export options:

υ Picture

The Picture plug-in provides several format options for saving your document view.

1. Select Picture from the Export submenu. The Save Picture Options dialog display

2. Choose the desired pixel depth from the Pixel popup menu.

3. Enter a value in dots per inch to specify the resolution at which the picture is to be
saved.

4. Select Dots, Millimeters or Inches from the units popup menus (constraining the p
portions of the image by checking the checkbox if necessary), then enter values f
width and height required.
B-2
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5. Click on the Resize to Window button to change the resolution back to 72 dpi and
width and height to the width and height of the contents of the document window.

6. Click OK to accept the options as set. 

7. The standard save dialog then displays, enter a name and select a location to sav
file.

8. At this stage you can choose the type of image file you want from the list displaye
the save dialog.

9. Click Save to save the image.

10.  A small dialog will show, displaying the current progress of the render to file.

Note: You may stop the export at any time by clicking on the cancel button in the dialog.
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Appendix C

Menu Command Plug-ins

Menu command plug-ins are accessed via the Plug-in menu or Animation
menu.
Table of Contents

Introduction C-2

PLUG-INS MENU C-3

Auto Save C-3

Base Plate C-4

Construct Idler C-4

Counter C-4

Gravity C-5

ANIMATION MENU C-6

Export Movie C-6

Light Start C-6

Light Stop C-7

Object Color Start C-7

Object Color Stop C-8

Object Texture Start C-9

Object Texture Stop C-10
C-1
Return to main table of contents
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υ Introduction

Select Plug-ins or Animation from the menu bar. 

A list of available menu command will displays. Select the name from the list to use that
ture. Hold down the Option key and select the name to display any options that are avai

The first time the Plug-in menu is selected, the top item in the menu, Last Plug-in, will b
grayed out. After selecting a menu command, the top item will then be the name of the m
command selected. This can be chosen by selecting the top item or typing Command - 
C-2
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PLUG-INS MENU

υ Auto Save

Select Auto Save to turn on the Auto Save feature. A dialog displays for you to enter a va
the Auto Save period.

Enter a value in minutes and click OK. A check mark will display next to the plug-in nam
show that Auto Save is on.

After the specified period, a dialog displays warning that it is time to save. The dialog off
the opportunity to turn Auto Save off, to close the dialog without saving, to automatically 
in future, or to save the document. To make this dialog disappear, but still save, just click
Automatically Save in Future.

To turn Auto Save off, select the plug-in name again from the plug-in menu.
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υ Base Plate

The Base Plate plug-in allows the user to add a plate onto the grid. The purpose of this p
to allow the model to cast shadows whilst being rendered, thus giving more depth and re
to the model created. To enable the base plate, simply click on it in the plug-in menu. The
will observe that a plate has been added to the grid, at roughly 90% of its size.

The plate itself is locked, and so cannot be moved, although you can unlock it to move i
around and change its color as you see fit.

υ Construct Idler

The Construct Idler plug-in is available as both a menu command plug-in and as an idle
in. See Construct Idler on page E-2 for details.

υ Counter

The Counter plug-in counts the number of objects and triangles in the selection or scene
C-4
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1. Make a selection to count only the number of objects and triangles in the selected
objects, or select nothing to count the number of objects and triangles in the entir
scene.

2. Choose Counter from the Plug-in menu.

3. The number of objects and triangles is counted, and the result displayed in the He
ette. (Select Help from the Palette menu to display the Help palette.)

υ Gravity

The Gravity plug-in is available as both a menu command plug-in and as a plug-in modi
See Gravity on page H-8 for details.
C-5



lights.

om-
 now 
mating.

enu 
ANIMATION MENU

υ Export Movie

The Export Movie plug-in saves the current animation as a Quicktime movie.

1. Select Export Movie plug-in from the Animation menu

2. A standard Save dialog displays.

3. Enter a name and select a location to save the movie.

4. The animation will then be recorded frame by frame by the current renderer.

υ Light Start

The Light Start plug-in is used to animate the color and brightness of a light or group of 

To animate the color or brightness of a light, first select the light. The Light Start menu c
mand will then highlight if a light is selected. By selecting the menu command the light is
tagged to allow the lights color and brightness to animate when the current scene is ani

To set the Animate Color options, hold down the Option key and select the Light Start m
command. The Animate Color Options dialog will display:
C-6
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• Color Hue: Enter a value in the hue field to specify the number of degrees 
around the color wheel to move each second to select the colors to apply. 
The default is 10.

• Brightness: Enter a value between 0 and 360 to specify the percentage 
change in brightness of the color per second. Each second the brightness of 
the color will change by that set percentage value, cycling around to get 
darker, brighter and darker again. The default is 0.

• Strobe on time: Enter a value in seconds for the length of time the light 
should stay on.

• Strobe off time: Enter a value in seconds for the length of time the light 
should stay off.

Click OK to enter the options. They will remain as set until changed.

υ Light Stop

The Light Stop plug-in is used to stop the animation of a light or group of lights.

To stop an animating light, first select the light. The Light Stop menu command will then 
light if the light selected has a light animation. By selecting the menu command the light
then untagged causing the light to stop animating when the current scene is animating. 

Light Stop has no options or options dialog.

υ Object Color Start

The Object Color Start plug-in is used to animate the color applied to an object or group
objects.

To animate the color of an object, first select the object. The Object Color Start menu co
mand will then highlight, selecting the menu command will tag the object to allow the col
animate when the current scene is animating.
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To set the Animate Color options, hold down the Options key and select the Object Colo
menu command. The Animate Color Options dialog will display:

• Hue: Enter a figure in the hue field to specify the number of degrees around 
the color wheel to move each second to select the colors to apply. The 
default is 10.

• Saturation: Enter a value between 0 and 360 to specify the percentage 
change in saturation of the color per second. Each second the saturation of 
the color will change by the percentage value set. The default is 10 but to 
stop this effect set the value to 0.

• Brightness: Enter a value between 0 and 360 to specify the percentage 
change in brightness of the color per second. Each second the brightness of 
the color will change by the percentage value set. Cycling around getting 
darker, brighter and darker again. The default is 0 which has no effect on 
the color brightness.

Click OK to enter the options. They will remain as set until changed.

υ Object Color Stop

The object Color Stop plug-in is used to stop the animation of the color applied to an ob

To stop a color animating on an object, first select the object. The object Color Stop men
command will then highlight if the object or object in a group selected has an animated c
By selecting the menu command the object is then untagged causing the color to stop a
ing when the current scene is animating. 
C-8
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υ Object Texture Start

The Object Texture Start plug-in is used to animate a texture applied to an object. 

To animate a texture on an object, first select the object. The Object Texture Start menu
mand will then highlight if an object is selected and has a texture to animate. By selectin
menu command the object is now tagged to allow the object’s texture to animate when t
rent scene is animating. 

To set the Animate Texture options, hold down the Option key and select the Object Tex
Start menu command. The Animate Texture Options dialog will display:

• Velocity: Enter a figure in the Velocity field to specify how many times the 
applied texture should move around the object per second. The default is 
0.1

• Direction: To change the direction in which the texture moves, enter a 
value between 0 and 360 in the Direction field. If set at 90 degrees the tex-
ture will move from top to bottom, 180 degrees from left to right, 270 
degrees from bottom to top, and so on. The default is 0 degrees.

•  Rotation: Enter a value between 0 and 360 in this field to start the texture 
rotating. Each second the texture will rotate by the amount specified. The 
default value is 0 degrees. 

Click OK to enter the options. They will then remain as set until changed.
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υ Object Texture Stop

The Object Texture Stop plug-in is used to stop the animation of a texture applied to an o

To stop a texture animating on an object, first select the object. The Object Texture Stop
command will then highlight if the object selected has an animated texture. By selecting
menu command the object  is then untagged causing the texture to stop animating when
current scene is animating.

Object Texture Stop has no options or options dialog.  
C-10
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Appendix D

Plug-in Palettes

Plug-in palettes are accessed via the Palettes menu. Select the palette name
from the list to open it.
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υ Introduction

Click on Palettes in the application menu bar to display a list of available palettes. Selec
palette name from the list to open it.

The Tools, Info and Help palettes are not plug-in palettes but are part of the core applica
See Chapter 4 — Palettes on page 4-1 for details.
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Tabbed palettes

When a palette is opened it displays in a window with the palette name on a tab at the t
the palette.

Tabbed palettes can be stacked together by simply clicking on the palette tab and dragg
palette onto the tab area of another tab palette:

Both palettes then appear in the same palette. To access a palette click on its tab.

Any number of tabbed palettes can be stacked together, although in practice you may w
limit this to the number of tabs that are visible in a palette.
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To remove a tabbed palette from a stack, click on the palette tab and drag the palette on
desktop.

The palette will appear on its own, while the other palettes remain stacked together.

Click on a palette tab and hold down the mouse button to display the tab menu. This pro
an alternate method of selecting other palettes or of disconnecting a palette from the sta
D-5
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υ Align

The Align palette is used to align objects in any or all of the X, Y and Z axes.

1. Select Align from the Palettes menu to display the Align palette:

2. Select two or more objects in the document window then click on the buttons in th
Align palette to specify how the objects should be aligned in the X, Y and Z axes.

If one or more of the selected items are locked, they will not be moved, but other selected
will be aligned with the locked items. Locked items are treated as a single object for align
purposes.

The line of alignment relates to the object that is in the most extreme position in the rele
direction. For example, when choosing align right in the X-axis, the line of alignment is 
defined as the right edge of the bounding frame of the object furthest to the right.
D-6



ath, 
tion 

. Click-
lette. 

 will 
 points 

Enter 
υ Animation Path

The Animation Path palette is used to move an object or the camera along a specified p
over a set time. To use the Animation Path palette you will first need to create an Anima
Path with the Anmation Draw Path Tool. 

Select Animation Path from the Palettes menu to display the Animation Path palette:

Animation Path Controls

  +Object

The +Object button will enable when both an object and an animation path are selected
ing this button will cause the object have tween points added in th Animation Tweener pa
These points will correspond to the Animation Path selected.

 +Camera

The +Camera button will enable when an animation path is selected. Clicking this button
cause the camera to have tween points added in the Animation Tweener palette. These
will correspond to the Animation Path selected.

 Start Time

The value displayed in the Start Time field is the Animation Path inital value in seconds. 
a value and press the Return, Enter or Tab key to change the Start Time value.

 End Time
D-7
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The value displayed in the End Time Field is the Animation Path final value in seconds. E
value and press the Return, Enter or Tab key to change the End Time value. 

 Reset

The reset button when clicked will change the start and end time value to the current do
ments animation values. 

 Display Animation Paths

Controls the visibility of an Animation Paths in the current document.

Object Options

 Rotate

The object is rotated as it moves along the path so that it maintains its orginal orientatio
relation to the path.

 Scale

If the Animation Path has been scaled at any point using the Animation Edit Path tool, th
object will also be scaled at that point. 

 Twist

If the Animation Path section has been rotated at any point using the Animation Edit path
the object will also be rotated around the path at that point. 

Camera Options

Note: To view the effect of the following different camera options open the NaviCam pale
the animation is running.

Animate Camera

 Along Path

The camera is moved along the path.
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 Fixed Point

The camera is moved along the path with a fixed view point.

 Fixed Direction

The camera is mved along the path with its view point in a fixed direction.

Animate View Point

 Along Path

The camera’s view point is moved along the path with the camera following behind. 

 Fixed Point

The view point is moved along the path while the camera is in a fixed position.

 Fixed Direction

The view point is moved along the path while the camera follows behind at a fixed distan
and fixed to a set direction.

Note: The object or camera is not linked to the path in any way. if the Animation Path is 
sedited, the animation for the camera will not be changed. To update an animation of an
or camera along a new path just click the appropate button and the new animation will re
the old animation. 

υ Animaton Player

The Animation Player palette is used to control the display of animation in the documen

Select Animation Player from the Palettes menu tp display the Animation Player palette:
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AnimationPlayerControls

 Move To Start

Click on the Move to Start button to move to the beginning of the timeline. 0/0 will be dis
played in the Time field, and slider on the timeline bar will displayer at the left end of the

 Play Backward

Click on the Play Backward button to play an animation in reverse direction.

 Pause

Click on the Pause button to pause an animation playing.

 Play Forward

Click on the Play Forward button to play an animation.

 Move to End

Clicking on the Move to End button to move to the end of the timeline. The value set in t
Duration field will be displayed in the Time field, and the slideron the timeline bar will disp
at the right end of the bar.

 Timeline Bar
D-10



e 
ne.

nter a 

alue.

Enter 

e end 

ing 

ning 

mouse 
ter 
The slider bar represents the timeline for the animation. Click on the slider, hold down th
mouse button and drag the slider right or left to move to a different position on the timeli

 Start Time

The value displayed in the Start Time field is the animation’s start position in seconds. E
value and press the Return, Enter or Tab key to change the Start Time value.

 Current Time

The value displayed in the Current Time field is the animation’s current position in sec-
onds.Enter a value and press the Return, Enter or Tab key to change the Current Time v

 End Time

The value displayed in the End Time field is the animation’s current position in seconds.
a value and press the Return, Enter or Tab key to change the EndTime value.

 Once

Click on the Once radio button to specify that an animation should run once through to th
then stop.

 Cyclic

Click on the Cyclic radio button to specify that an animation should play constantly, runn
through to the end then returning to the start to play again.

 Oscillate

Click on the Oscillate radio button to specify that an animation should play constantly, run
through to the end, playing backward from the end to the start, and playing again.

 Speed Bar

The slider bar represents the speed for the animation. Click on the slider, hold down the 
button and drag the slider left or right to move to a different speed of animation. The cen
point alwas represents normal speed.
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 Minimum Speed

The value displayed in the Minimum Speed field is the animation’s slowest possible fram
gression in seconds. Enter a value and press the Return, Enter or Tab key to change th
mum speed value.

 Current Speed

The value displayed in the Current Speed field is the animation’s current frame progess
seconds. Enter a value and press the Return, Enter or Tab key to change the minimum 
value.

 Maximum Speed

The value displayed in the Maximum Speed field is the animation’s fastest possible fram
gession in seconds. Enter a value and press the Return, Enter or Tab key to change the
mum speed value.

υ Animation Tweener

The Animation Tweener palette is used to specify the position, size and rotation of the ob
the position, direction, zoom factor and view type of the camera at a specific time. The s
fied position is called a tween point, the positions between the set tween points are calc
by the computer.

Select Animation Tweener from the Palettes menu to display the Animation Tweener pal
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Animation Tweener Controls 

 Move To Start

Clicked on the Move to Start button to move to the beginning of the timeline. 0.0 will be 
played in the Time field, and the slider on the timeline bar will display at the left end of th

 Move to Previous Tween

Click on the Move to Previous Tween button to move the timeline to the previous tween 
point in the current animation.

 Play Backward

Click on the Play Backward button to play the current animation in reverse direction.

 Pause

Click on the Pause button to pause the current animation.

 Play Forward

Click on the Play Forward button to play the current animation.

 Move to Next Tween

Click on the Move to Next Tween button to move the timeline to the next tween time poin
the current animation.

 Move to End

Click on the Move to End button to move to the end of the timeline. The value set in the 
tion field will be displayed in the Time field, the slider on the timeline bar will display at th
right end of the bar.

 +Object
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Use the +Object button to add a tweenpoint for an object. This specifies the position, siz
rotation of the selected object at a particular time.

 +Camera

Use the +Camera button to add a tween point for the current camera. This specifies the
tion, direction, zoom factor and camera type at a particular time.

 +Ambient

Use the +Ambient button to add a tween point for the current ambient light levels. This s
fies the brightness, color and if it is on or off at a particular time.

 +Sun

Use the +Sun button to add a tween point for the sunlight. This specifies the position, br
ness, color and if it is on or off at a particular time. 

Note: To delete a tween point, select the desired triangle marker and press the Delete ke

 Tween increment time value

The Tween increment time value specifies the time in seconds the timeline will move for
after a tween point has been added.

Note: Holding down the Option key stops the timeline moving forward.  

 Timeline

In the lower part of the Animation Tweener palette a table displays the list of objects with
tween points which are displayed in the Object Name column. Objects can be selected 
document window by selecting an Object name in the list and vice versa.

The time in seconds is displayed in the first line of the table, and the current animation ti
marked with a blue thumb at the top of the table and a vertical red line. To move the cur
animation time 

 Zoom
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Using the zoom controls at the bottom left of the palette to zoom in and out on the table
playing a longer or shorter section of the timeline.

υ Axis

The Axis palette is used to display the current orientation of the front window’s camera.

Select Axis from the Palettes menu to display the Axis palette:

Select the Rotate tool in the Tool palette, click on the document grid and, holding down 
mouse button, drag to rotate the grid. Notice that the positions of the axes in the Axis pa
are updated to reflect the new orientation of the grid.
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Click on the palette’s zoom button to extend the Axis palette:

The axes are listed and the color of each axis shown. Next to the axis name is a checkb
is used to display or hide the axis. Checking the check boxes on or off to specify which 
should be displayed in the palette.

υ Color

The Color plug-in displays a color picker, so that an object’s color or the default color ca
changed easily.

1. Select Color from the Palette menu to display the Color palette:

2. To change the color of an object, several objects, or a group, make a selection in 
document window. If nothing is selected, the default color will be changed.

3. Choose a color from the Color palette by clicking on the color wheel and/or adjus
the brightness slider bar and values for Red, Green, Blue, Hue, Saturation and Va

4. Click on the current color button to display the system color picker(s) if necessary

Note: Colors can be dragged to and from the current color button.
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υ Color Palette

The Color Palette plug-in provides a repository for 12 colors.

1. Select Color Palette from the Palette menu to display the Color Palette:

2. To use a color in the Color Palette, drag and drop it onto an object, the background
or color box in the Info Palette, or select an object in the document window and clic
a color in the Color Palette.

3. To change a color in the Color Palette, drag and drop a new color over an existing
or, when nothing is selected in the document, click on a color to open the color pi
and choose a new color.

υ Construct

The Construct palette is used to perform CSG (Constructive Solid Geometry) Boolean o
tions by cutting into one geometry with another.

Select Construct from the Palettes menu to display the Construct palette:
D-17



ecify 

ecify 

d:

g this 

d sur-
d A, 
ct, 

 an 
1. In the document window, position two objects so that they intersect:

2. Select one of the objects (in this example, the cube) and click on the A button to sp
that this should be a type A object.

3. Select the other object (in this example, the sphere) and click on the B button to sp
that this should be a type B object.

4. Clicking on the Mode buttons selects the type of construction that will be performe

• A Add B: Creates a geometry that has only the outer surfaces of A and B. Choosin
option will have no visible effect.

• A Subtract B: Display only the portion of object A not intersected by object B:

• A Split B: Creates two geometries that has surface of object A and the intersecte
faces of object B. The object part that was not intersected by object B is assigne
the other object part is assigned B. Choosing this option will have no visible effe
until Make Permanent is clicked.

• A Intersect B: Display only the portion of object A that is intersected by object B:

5. The geometry displayed will be updated interactively to reflect the new position of
object as it is moved.
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6. If you have the Construct Idler plug-in loaded, one of the objects may be invisible, 
can still be selected and moved. The geometry displayed will be updated to reflec
new position of the object.

7. Click on the Make Permanent button to create a permanent geometry. This may t
few seconds to calculate. The Make Permanent action can be undone if the desir
effect is not achieved, and the objects repositioned.

The Mode button controls described are global controls and will affect all CSG objects in
document that have not been made permanent. As many objects as you wish may be sp
as type A and type B type CSG objects and will all interact with each other according to 

The Construct Plug-in Tool

The Construct plug-in is a plug-in modifier tool. See Construct on page H-7 for more details

υ Cursor Options

The Cursor Options palette allows you to control the alignment and positioning of objects
other objects, and the display and positioning of the cursor. Select Cursor Options from 
Palettes menu to display the palette. Click on the shrink/expand button at the top right o
palette to show or hide the lower section.
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Snapping Options

Snapping is the alignment of points with other points. When positioning objects, snap lin
will display and a sound will play when the snap points of the selected objects are aligne
the snap points of unselected objects.

• Enable Snap: Click on this check box to turn the Snapping features on or off. Alternativ
hold down the Control key and press the space bar to switch Snapping on or off.

• Snap to Bounding Box: Click on this check box to activate the eight corners of each obje
bounding box as Snapping points.

• Snap to Mid Points: Click on this check box to activate the mid points of each object’s 
bounding box as Snapping points, i.e. The points half way between the eight corner 
of the bounding box.

• Snap to Hot Spots: Click on this checkbox to specify that an object’s Hot Spots should 
activated as Snapping points. Hot Spots are points in addition to the corners and m
points of an object’s bounding box. These are automatically added to wall objects an
be added to door and window objects. Hot Spots are added to wall objects at the to
bottom of the wall at each corner. When placing doors and windows in a document,
Windows and Doors palette includes a check box allowing you to choose whether to
Hot Spots or not. If added, Hot Spots are positioned at the points where the window
door intersects with the wall.

• Multiple Snap Lines: If this option is checked on, snap lines will display for all current 
alignments. If checked off, snap lines will display only for the first alignment found in
each axis.

• Play Snap Sounds: Check this option on to play sounds according to the snapping statu
objects being positioned. Three different sounds play in the following circumstances
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If a point is aligned with, but not snapped to, another point.

If a point is snapped to another point.

If a point in no longer aligned with or snapped to another point.

• Snap Line Color: Click on this box to display the Color Picker and select the color used
display the snapping lines.

3D Cursor

• Show Cross Hairs: Check this option to display cross hairs showing the position of the 
sor in the document in 3D space.

• Floating Cursor:  The cursor defines a position and an orientation for entering new obj
and usually snaps to the surface of any object below the cursor arrow. Check this op
specify that the cursor should not snap to the surface of any object below it, and shou
orientate itself in relation to that surface.

υ Item Tag

The Item Tag palette is a palette that is designed to allow the easy design of doors and w
in Microspot Modeler for Microspot Interiors. Essentially to tag a model as a door in Inter
select the item and click on the door button in the item tag palette. Similarly for windows
Then when one of the tagged models is imported into Interiors from Modeler, Interiors w
know to treat the model as a door or window, depending on the tag used. See the Windows And
Doors Tutorial on page 2-84 for more details.
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υ Libraries

The Libraries palette displays libraries of furniture items, doors, windows, textures, color
that can be used in your 3D scene.

Select Libraries from the Palette menu. The first time the Libraries palette opens, it open
the default libraries of the program. Every time after this the Library palette retains the li
the libraries selected:

Selecting Library Items

When you click on an item that is stored in a library it will be outlined with a black rectang
show it is selected:
D-22
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Storing Data

3DMF, PICT, and data in various other image formats can be stored in libraries. Modele
includes several libraries of furniture and accessory items, doors and windows, colors a
tures, but you can also use the Libraries palette to store your own items. To do this drag
drop objects/groups of objects from Modeler into a library. You can also visit the Microsp
website to download more libraries, See Microspot Library Download on page 3-36.

Naming Items

Items are displayed in a library in the order in which they were entered.

If an item has a name attached to it, this name is displayed in the Name field at the bott
the palette when the item is selected. Unnamed items will display as untitled.

To name or rename an item, select its icon and enter a name in the Name field. Press th
or Return key, select another object or click on an empty space in the library and the ite
be updated with its new name.

Retrieving Data

To retrieve data from a library, drag and drop an item directly into your Modeler docume

Find

Library items can be searched for by name. Enter text into the Find field at the top right 
Libraries palette. The first item found that matches the entered text will be selected:

Note: The Libraries palette searches for names that match or start with the name you en
D-23
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Window Controls

Zoom In/Out

The Zoom controls at the bottom left of the palette can be used to increase/decrease the
the palettes contents:

Horizontal/Vertical Arrows

• Horizontal Arrow: In the By Icon view, click on this button to display the Libraries pale
with a horizontal scroll bar. In the By List view, click on this button to display the prev
to the left of the item list:
D-24



w 

• Vertical Arrow: In the By Icon view, click on this button to display the Libraries palette 

with a vertical scroll bar. In the By List view, click on this button to display the previe
above the item list:

Delete Button

• Delete: The Delete button removes the current selected library item:
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File Menu

New

Select New to open a new library. The standard dialog will display, allowing you to enter
name for the new library and specify a location to save it. A new, empty library will displa
the Libraries palette:

Open

Select Open to open an existing library. A standard Open dialog will display for you to se
the library to open. The selected library will display in the Libraries palette.

Open Defaults

On selecting Open Defaults all the programs existing default libraries will be displayed in
Libraries palette. 
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Close

Choose to close the current library. The Libraries palette save the library file whenever yo
data, so you do not need to save any changes. The Libraries palette will remain open an
display the contents of any other open libraries.

Close All

Choose to close all open libraries. The Libraries palette will remain open but will be emp

View Menu

By Icon

Select By Icon from the View menu to display picture previews of a library’s contents. 
Although the items’ names will not be displayed, you may still search for items by name 
the Find field at the top right of the Libraries palette.

By List

Select By List from the View menu to list a library’s contents by name. When By List is 
selected you can also choose whether to see a preview of an item when it is selected in

• Preview above: The preview is displayed above the list:
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• Preview to left: The preview is displayed to the left of the list:

• No preview: No preview of selected items is displayed:

Display Menu

The display menu lists all the libraries currently open. Select a library’s name from the li
display it or choose Show All to display the contents of all the open libraries in the order
which they were opened.
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υ Lights

The Lights Palette is used to control the various lighting features available in the applica
Select Lights from the Palettes menu to display the palette:

Note: The Preferences dialog, accessed from the Edit Menu, contains a check box for G
Lights. If the Global Lights control is turned on, any changes made via the Lights palette
affect the whole document. If the Global Lights control is turned off, making changes in t
Lights palette will affect only the current window. See Preferences on page 3-5 for further 
details.

Spot/Point Brightness

Lights are placed in documents by dragging and dropping light objects or furniture items
including lights into the document. When a light is placed in a document, its color, bright
spread and sharpness can be adjusted via controls in the Info Palette. See Info Palette on page
4-17 for further details.

• To manipulate all point or spot lights at once, use the Spot/Point Brightness slider co
in the Lights Palette.

• Use the checkbox to the right of the slider bar to turn all the point or spot lights on o

Ambient Brightness

Ambient light is the equivalent of daylight. It is a diffused light that has no specific point o
origin and casts no shadows.

• Use the Ambient Brightness slider bar to adjust the brightness of the ambient light.

• Click on the color box to display the Color Picker and select a color for the ambient l
or drag a color onto the color box.
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• Use the checkbox to the right of the color box to turn ambient light on or off.

Sun Brightness

By default, sunlight shines from the South East at an angle of 45°. The direction of the su
can be adjusted using the Sun Direction plug-in. See Sun Direction on page H-11 for further
details. Sunlight will affect your view of an object, and some surfaces will reflect more lig
than others.

• Use the Sun Brightness slider bar to adjust the brightness of the sunlight

• Click on the color box to display the Color Picker and select a color for the sunlight, 
drag a color onto the color box.

• Use the checkbox to the right of the color box to turn sunlight on or off.

Show Lights Markers

Use this checkbox to specify whether Point and Spot Light Markers should be hidden or
played. The effects of the lights will be apparent regardless. Non-interactive renderers (s
the Microspot Renderer) will not display light objects whether they are hidden or not. See 
Appendix I — Microspot Plug-in Renderers on page I-1 for more details.

υ NaviCam

The NaviCam palette provides a way of controlling the camera position and view.

Select NaviCam from the Palette menu to display the NaviCam palette.

Height Area
Position Plan

Zoom

Position Buttons

Grid Height

Clipping Planes
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The red square displayed in the palette, both in the height area and in the position plan,
sents the camera. The line from this square shows the camera view direction and at the
this line is the look at point or point of interest.

Height

Use the controls in the Height Area to adjust the position of the camera, or point of intere
the Y dimension. 

The long green line in the Height Area represents the grid height. The lines above it repr
height as determined by the size of the grid and each grid square.

• Click on the camera square and move it up or down to change the camera height w
maintaining the point of interest.

• Click on the view direction line (or anywhere in the Height Area except the camera 
square) and drag up or down to change the height of the point of interest without cha
the camera height. This is the same as tilting the camera.

• Hold down the Option key, click anywhere in the Height Area and drag up or down to
adjust the height of the camera and move the point of interest relative to the camera
height.

If the camera is moved out of the height range shown, the display will be rescaled so tha
camera square can still be seen. When the camera is moved back into range, the display
rescaled again.

Position

Use the controls in the Position Plan to adjust the position of the camera or the point of in
in the X and Z dimensions.

The Position Plan displays an image of the 3D scene in plan view.

• Click on the camera square and drag to change the position of the camera while ma
ing the point of interest.

• Click on the view direction line (or anywhere in the Position Plan except the camera
square) and drag to change the position of the point of interest without moving the ca
position. This is the same as turning the camera.

• Hold down the Option key, click anywhere in the Position Plan and drag to move the
era and move the point of interest relative to the camera position. This is the same a
step and crab movements of the camera.
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If the camera is moved out of the plan shown, the display will be rescaled so that the ca
square can still be seen. When the camera is moved back into range, the display will be
caled again.

Zoom

Click on the Zoom button and drag up or down to zoom in or out on the scene.

Clipping Planes

The Clipping Plane controls are used to adjust the camera’s front (Hither) and back (Yon
ping planes.

Although the clipping planes themselves are invisible, the effect they have on objects in 
document can be seen. The front (Hither) and back (Yon) clipping planes can be set so th
view only a section of the document. Any objects or parts of the objects closer to the cam
than the front (Hither) clipping plane, or further from the camera than the back (Yon) clip
plane, will not be visible.

Hither Clipping

Click on the Hither Clipping button and drag up to move the front (Hither) clipping plane 
ther away from the camera or down to move the front (Hither) clipping plane towards the
era.

Yon Clipping

Click on the Yon Clipping button and drag up to move the back (Yon) clipping plane fu
away from the camera or down to move the back (Yon) clipping plane towards the came

Position Buttons

Use the position buttons to move either the camera or the point of interest to predefined
tions.

• Click on the position buttons to move the camera while maintaining the point of inter
0° moves the camera to directly behind the point of interest, 90° to the right, 180° dir
in front of, 270° to the left, and so on.
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• Hold down the Option key and click on the position buttons to move the point of inte
while maintaining the camera position. 0° moves the point of interest to directly beh
the camera, 90° to the right, 180° directly in front of, 270° to the left, and so on.

• Click on the ‘Mid’ button to move both the camera and the point of interest to predet
mined locations. The point of interest is positioned at the centre of the grid. The cam
placed half way between the centre and the side of the grid, directly in front of the po
interest. The camera will be at approximately eye height and tilted down slightly.

υ Nudge

Use the Nudge palette to move or rotate an object by a specified amount.

Select Nudge from the Palettes menu to display the Nudge palette:

Move

1. Select an object in the document window.

2. Enter a value in the Move box in the Nudge palette. The units used will depend on
set for the document in the Options menu. 

3. Click on the control buttons to choose the direction in which to move the selected
object. The direction relates to the current view.
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Rotate

1. Select an object in the document window.

2. Enter a value in degrees in the Rotate box in the Nudge palette.

3. Click on the control buttons to choose the direction in which to rotate the selected
object. The direction relates to the current view.

υ  Renderer Options

The Renderer Options plug-in palette is used to control the way that the document is disp
Choose Renderer Options from the Palettes menu to open the palette:

Move Up

Move Down

Move Left Move Right

Move Closer Move Further Away

Rotate Up

Rotate Down

Rotate Left Rotate Right

Rotate Anticlockwise Rotate Clockwise
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Camera

Select Perspective or Orthographic from the Camera pop-up menu.

• Perspective: Objects are displayed in perspective mode to give the illusion of depth. P
lel lines are drawn so that if extended, they would converge at a given point:

• Orthographic: Objects are displayed in Orthographic mode. Parallel lines remain para
regardless of the distance they are supposed to be from the camera:

Renderer

Click on the Renderer popup menu to display any available renderers.
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• Wire Frame: The surfaces of objects are not filled; only the edges of the surfaces are 
played:

• Interactive: Objects in the document are rendered using the programs interactive ren

• Microspot Preview Renderer: The scene is rendered using the Microspot non-interactive
renderer to produce a fast preview render of the scene with lighting and shadows. See 
Appendix I — Microspot Plug-in Renderers on page I-1 for more details.

• Microspot Renderer: The scene is rendered using the Microspot non-interactive render
produce a high quality final render. See Appendix I — Microspot Plug-in Renderers on 
page I-1 for more details.

Renderer Options

To the right of the Renderer popup menu is a button for Renderer Options. This is only ac
a non-interactive renderer is installed and selected. Click on the button to display any ava
options for the currently selected non-interactive renderer.

Note: Holding the Option key down while selecting the renderer will also display any opti
available.

Style

The Style pop-up menu is not available when the Wire Frame renderer is selected. Sele
of the following options from the menu:

• Filled: All surfaces are filled and rendered. Objects appear to be solid.
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• Edges: Only the edges of objects are rendered. This is different from Wire Frame mo
that lines are rendered according to the orientation of the object and any light sourc
rather than the lines being displayed as one solid color:

• Points: Only the vertex points of objects are rendered. Points are rendered according
orientation of the object and any light sources:

Shading

Select Plain, Smooth or Best from the Shading pop-up menu.
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• Plain: Surfaces are filled but not smoothed and steps of color can be seen within som
objects. Shading is applied according to the angle of the surface and any light sourc
will affect the object:

• Smooth: Surfaces are filled and smoothed. Shading is applied according to the angle 
surface and any light sources that will affect the object:
D-38



the 
 

ible 
ame 
• Best: Surfaces are filled and smoothed. Shading is applied according to the angle of 
surface and any light sources that will affect the object. This option also displays the
reflections of any lights:

Backface

The backface of an object is the side that faces away from the camera.

Select Show, Remove or Flip from the pop-up menu.

• Show: Select this option to show the backface of an object. This will not make any vis
difference if the object surfaces are filled, but if you are viewing the objects in wire fr
mode, you will be able to see the wire frame on the backface of the object:
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• Remove: Select this option to hide the backface of an object. This will not make any d
ence if the object surfaces are filled, but if you are viewing an object in wire frame m
its backface will not be displayed:

• Flip: The Flip option flips the backface so that the outside surface is now on the insid
This does not affect the shape of the object, but may alter the way it is rendered:

Show Grid

Documents are automatically displayed with a grid to help you design and position objec
3D. When this option is enabled, the grid will be displayed. Uncheck this option to hide t
grid.

Show Markers

When text and sound markers are placed in a document, you can choose whether or no
play them. Check the Show Markers option to display markers, or leave it unchecked to
markers. There is no marker tool in Modeler.
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υ Section

The Section palette is used to edit the section of geometries that are made up of paths a
tions. These are: 3D Text; cones; cylinders; irregular polygons; lathed objects; pipes; py
mids; and regular polygons.

If the Dynamic Updates application preference is checked on, as the section is edited th
geometry in the document window is updated to reflect the changes made and the resu
any actions can be seen instantly. If the Dynamic Updates preference is checked off, the
etry in the document window is updated only when the mouse button is released as an e
action is completed. See Preferences on page 3-5 for further details.

To display the Section palette, select Section from the Palette menu:

Coordinate Fields

Vertex Arc

Spline Bezier

External Contour Internal Contour

Delete Select All

Flip Vertical Flip Horizontal

Rotate Anticlockwise Rotate Clockwise

Zoom Out Zoom In

Revert
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Displaying An Object Section

Select a geometry in the document window and its section will display in the Section pa
The section is drawn in black with handles showing the various points on the section. Bl
lines show the x and y axes, and the object origin is at the point these two axes intersec

Types Of Point

• Vertex: A standard point used to define the beginning or end of a straight section
path or line.

• Arc: A point on a section of a circle defined as the center point on the arc betwee
vertex points.

• Spline: A point on a curve. The curve is defined automatically and cannot be ed
except by adjusting the points at either side of the spline point.

• Bezier: A point on a curve. Two Bezier handles allow the curve to be adjusted.

Vertex point handles display as squares, Bezier and spline point handles as diamonds, 
point handles as circles.

Selecting Points

Click on a handle to select it.
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Note: When selected, a Bezier point has two additional handles that allow you to adjust t
Bezier curve.

• To select additional points: Hold down the Shift key and click on another point.

• To deselect points: Hold down the Shift key and click on a selected point.

• To select several points at the same time: Hold down the Shift key and click and drag in the
Section palette to drag out a marquee selection:

• To select all the points in the section: Click on the Select All button in the Section palette.
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Moving Points

There are three methods of moving points of any type:

• Click on a handle and drag to reposition it.

• Enter coordinate values in the x and y fields at the bottom of the Section palette to m
point by precise values. The coordinates entered here relate to the section origin ra
than the grid origin.

• Use the arrow keys to move a point by two screen pixels at a time, or by the grid sna
distance if one is set.

When moving points by clicking and dragging or using the arrow keys, the section windo
will auto scroll so that you can see the new position of the point(s).

Manipulating Points

• Arc: Other adjustments can be performed by manipulating the vertex points at either e
the arc.

• Bezier: Click and drag on the Bezier handles to adjust the curve. Hold down the Con
key and click and drag on the Bezier point or Bezier handles to break the Bezier cur
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Changing Points

To change a point to a point of a different type, select the point then click on the Vertex, 
Spline or Bezier button in the Section palette. The point will change to the type selected

 Note: An arc point can only be added between two vertex points.

Adding Points To A Section

To add a point to a section, select two contiguous points on the section, then click on th
tex, Arc, Spline or Bezier button in the Section palette. A point of the appropriate type w
added between the two points originally selected.

Note: An arc point can only be added between two vertex points.

An alternative way of adding vertex or spline points is to hold down the Option key, click o
existing vertex or spline point and drag to place a copy of the point.

Note: Arc and Bezier points cannot be added in this way.
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External/ Internal Contour

The way light shines on a surface will be affected by whether a contour is defined as be
internal or an external contour. A contour is part of a section made up of a closed line.

For example, the cross section of the letter A contains two contours. By default they are
external contour and an internal contour. As the window cut out of the letter A is defined 
internal contour, the light is shown shining down on the bridge of the letter A and the oth
inside surfaces are in shadow.

To change the definition of a contour, select a point on the contour line and click on the 
nal Contour or Internal Contour button in the Section palette.

In the figure below, the internal contour of the letter A is selected and changed to an ext
contour. It is now treated as an external contour as far as the lighting effects are concern
the bridge of the letter A is now in shadow and the other inside surfaces have light shinin
them.

External Internal
Contour Contour
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Delete

Select a point or points in the Section palette and click on the Delete button to remove th
from the section.

Select All

To select all the points in the section, click on the Select All button in the Section palette

Flip Vertical/ Flip Horizontal

The orientation of the object’s section when it initially appears in the Section palette is d
mined by the way the original object was drawn and how the object’s internal data struct
held by Modeler. To view the section in the same orientation as the object as it now is di
played in the document window, it may be necessary to use the Flip Vertical or Flip Horiz
button to flip the section around the x or y axis. This affects only the view of the section i
Section palette, it does not affect the 3D geometry in the Modeler document window.

Rotate Anticlockwise/ Rotate Clockwise

The orientation of the object’s section when it initially appears in the Section palette is d
mined by the way the original object was drawn and how the object’s internal data struct
held by Modeler. To view the section in the same orientation as the object as it now is di
played in the Modeler document, it may be necessary to rotate the section in the Section
D-47



be 

eom-

 the 
on if no 

ected. 
e Sec-
by clicking on the Rotate Anticlockwise or the Rotate Clockwise button. The section will 
rotated by 90° in the relevant direction.
 

This affects only the view of the section in the Section palette, it does not affect the 3D g
etry in the Modeler document window.

Zoom In/ Zoom Out

Click on the Zoom In or Zoom Out button to zoom in or out of your view of the section in
Section palette. The view is centered on any selected points or on the center of the secti
points are selected.

Revert

Click on the Revert button to return to the section as it was when the object was first sel
This relates to the points on the section only, not to any view options you have used in th
tion palette.
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Moving the Section Window Contents

Click on the section window and drag to reposition window contents. The section window
autoscroll.

Changing the Object’s Origin

Click on X or Y axis and drag to reposition the location of the axis relative to the section.

When the X or Y axis is moved the origin will change, so the origin of the object’s path is
changed relative to the object’s section. 

υ Textures

Use the Textures Palette to manipulate a texture applied to an object.
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Select Textures from the Palettes menu to display the Textures palette:

The contents of the palette will be grayed out unless an object with a texture applied to 
selected.

When a texture is applied to an object it is scaled/stretched to fit once on each surface. T
ture can then be manipulated using the controls in the Textures palette.

Textures Palette Options

• Rotation: Enter a value between 0 and 359.9 in the rotation field and press the Retur
Enter or Tab key or use the rotation slider to adjust the degree of rotation of the text
applied to the object.

• Offset: Select Offset from the pop-up menu and the two slider bars to the right of the
up menu will relate to horizontal and vertical offset. The values for horizontal and ver
offset can be linked by clicking on the constrain box to the right of the slider bars.
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Horizontal Offset: Enter a value between 0 and 1 in the Horizontal Offset field and p
the Return, Enter or Tab key or use the slider bar to move the texture across the ob
a horizontal direction.

Vertical Offset: Enter a value between 0 and 1 in the Vertical Offset field and press 
Return, Enter or Tab key or use the slider bar to move the texture across the obje
vertical direction.

• Scale: Select Scale from the pop-up menu and the two slider bars to the right of the p
menu relate to horizontal and vertical scale. The values for horizontal and vertical sc
can be linked by clicking on the constrain box at the right of the slider bars.

Horizontal Scale: Enter a value between 0 and 25 in the Horizontal Scale field and p
the Return, Enter or Tab key, or use the slider bar to change the horizontal scale 
texture on the object.

Vertical Scale: Enter a value between 0 and 25 in the Vertical Scale field and press 
Return, Enter or Tab key or use the slider bar to change the vertical scale of the t
on the object.

• Flip Horizontal: Check the Flip Horizontal check box to flip the texture applied to the 
object around the horizontal axis.

• Flip Vertical: Check the Flip Vertical check box to flip the texture applied to the object 
around the vertical axis.
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• Clamp X: Check the Clamp X check box to prevent the texture being repeated in the 
axis. The texture offset can then be adjusted to position the strip of texture on the su

• Clamp Y: Check the Clamp Y check box to prevent the texture being repeated in the Y
The texture offset can then be adjusted to position the strip of texture on the surface

• If the texture is clamped in both the X and Y axes it is not repeated in either direction
texture can then be scaled and positioned on the surface as desired.
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• Play Movie: This option is only available if a movie has been applied to an object as a
ture. Click on the Play Movie button to start the movie playing. Note: the movie will o
play if animation is turned on and is not paused. If animation has been turned off or
paused via the Animation Player palette (see Animation Path on page D-7)0 the movie 
will not play until animation is turned on again.

• Stop Movie: This option is only available if a movie has been applied to an object as a
ture. Click on the Stop Movie button to stop the movie playing.

• Import: Click on the Import button to display a standard dialog that allows you to sele
PICT, TIFF, JPEG, GIF, PICT clipping or movie file to import as a texture or else just 
and drop directly onto objects in the document window, as long as the Textures pale
plug-in is loaded.

• Sound: Use the Sound control to change the volume of the sound of any movie appli
a texture on a selected object. Click on the sound icon and a pop-up menu displays.
the level of sound required.

υ Tripod

The Tripod palette provides an alternate method to the NaviCam palette for a way of cha
the view in the current document window. 

Select Tripod from the Palettes menu to display the palette:

Height

Step/Crab

Zoom

Pan/Tilt

Look At Selected

Zoom Out Zoom In

Adjust Height

Home View

Crab

Step

Crab

Pan/Tilt

Hither Clipping

Yon Clipping
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The Tripod palette displays a graphic of a camera on a tripod. A variety of buttons provid
trols for manipulating the camera, the above dialog shows how those controls are used. I
cases click on the button to perform the relevant action. When using those buttons marke
italic text, click on the button and drag to perform the desired action.

• Look At Selected: Select an object in the document and click on the Look At 
Selected button to position the camera to centre the selected object in its view.

• Zoom: is used to narrow or widen the focus of the camera lens

• Height: The Height controls are used to change the height of the camera.

• Pan/Tilt : The Pan/Tilt controls are used to change the camera’s angle by turning 
it left and right or tilting it up and down.

• Step/Crab: The Step/Crab controls are used to move the camera closer, further 
away, left, and right.

• Home View: Click on the Home View button to return the camera to its initial 
position (the view displayed when a new file is opened).

• Hither Clipping : Click on the Hither Clipping button and drag up to move the 
front (Hither) clipping plane further away from the camera or down to move the 
front (Hither) clipping plane towards the camera.

• Yon Clipping: Click on the Yon Clipping button and drag up to move the back 
(Yon) clipping plane further away from the camera or down to move the back 
(Yon) clipping plane towards the camera.

Note: Although the clipping planes themselves are invisible, the effect they have on obje
the document can be seen. The front (Hither) and back (Yon) clipping planes can be set 
you view only a section of the document. Any objects or parts of the objects closer to the
era than the front (Hither) clipping plane, or further from the camera than the back (Yon)
ping plane, will not be visible.
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Appendix E

Idler Plug-ins

Idler plug-ins have no interface and run constantly in the background when
loaded.
Table of Contents
Construct Idler D-2
E-1
Return to main table of contents
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υ Construct Idler

The Construct Idler has two functions:

• Performing CSG (Constructive Solid Geometry) Boolean calculations. CSG operations allow 
one geometry to cut into another — enabling you to see into a room through a windo
example. The calculation is performed each time an object with a CSG attribute is 
changed, and may take a few seconds depending on the complexity of the documen
objects must have the appropriate CSG attributes applied to them, by using a plug-in
allows CSG attributes to be applied to objects, or by using library items that already 
CSG attributes applied. Door and window library items supplied with the application,
walls drawn with the wall drawing tools, include the correct CSG attributes.

• Automatically simplifying objects as rendering speed decreases. When the Construct Idler is 
checked on in the Plug-in menu and rendering speed falls below 4 renders per seco
plug-in starts to simplify the objects in the scene that contain the most triangles, by tu
them into cubes. This allows you to continue to edit a complex document in real time,
on one of the slower computers. Any selected items, windows and doors are not affe
by this process. Items are re-drawn in full once the editing action is complete.
E-2



F

Appendix F

Plug-in Tools

Individual plug-in tools are discussed in Appendix G — Plug-in Geometries
and Appendix H — Plug-in Modifiers. This appendix provides information
relevant to both types of plug-in tool.
Table of Contents

Introduction F-2

Configuring The Tools Palette F-2

Tool Options F-3
F-1
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υ Introduction

Plug-in tools are either plug-in geometries or plug-in modifiers. See Appendix G — Plug-in 
Geometries on page G-1 and Appendix H — Plug-in Modifiers on page H-1 for details o
vidual plug-ins. When loaded, plug-in tools appear in the Tools palette and can be position
the palette by the user as discussed below.

υ Configuring The Tools Palette

When Modeler is launched with all the plug-ins loaded, the plug-ins are placed in the To
palette in a default order.

The Tools palette is configurable, so you can move tools around to position them in the 
tion or group that is most convenient or logical for you.
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Configure the Tools palette in the following way:

• Click on a tool and hold down the mouse button to display a pop-up menu showing 
other tools in the stack (if any). Select the name of a tool in the pop-up menu to sele
tool and bring it to the top of the stack.

• To move a tool, hold down the Command key, click on the tool and drag it to a new l
tion.

• Drop a tool onto another tool to stack them together.

• Drop a tool onto the four selection tools at the top of the palette to separate it from a 
of stacked tools and add it to the top of the tool palette as an individual tool.

υ Tool Options

To open a dialog showing any options available for a tool, use either of the following me

• Hold down the Option key and select the tool in the Tools Palette.

• Click on the tool in the Tools palette and hold down the mouse button. Select the sam
from the pop-up menu that displays.

Note: There are no options available for the Arrow, Rotate, Rectangular Marquee and Ha
tools.
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Appendix G

Plug-in Geometries

Plug-in Geometries are plug-in tools that are used to create objects. When
installed they are located in the Tools palette.
Table of Contents

Introduction G-2

3D Text G-2

Animation Draw Path G-4

Cone G-6

Cube G-8

Cylinder G-9

Irregular Polygon G-11

Lathe G-13

Pipes G-17

Point Light G-22

Pyramid G-23

Regular Polygon G-24

Sphere G-27

Spot Light G-28

Torus G-29
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υ Introduction

When loaded, Plug-in Geometries appear in the Tools palette. The position of each plug
within the Tools palette will depend on how the user has configured the palette. See Configur-
ing The Tools Palette on page F-2 for more details. The default arrangement is shown below

Select the plug-in tool to use by clicking on the icon of that tool in the Tools palette.

υ 3D Text

The 3D Text plug-in is used to create three dimensional text. Once created, the text can
manipulated like any other 3D object.

3D Text

Animation Draw Path

Sphere

Point Light

Spot Light

Torus

Cylinder

Regular Polygon

Cone

Cube

Pyramid

Irregular Polygon

Pipes

Lathe
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Select the 3D Text plug-in from the Tools palette and move the cursor over the documen
dow. The cursor will change to a text insertion icon.

Click on the place you wish the text to appear. The Enter text dialog will display. Note: If
have a lot of fonts installed on your Mac, it may take a few seconds for this dialog to app

Enter the text in the top field and choose a font, style and text quality from the popup me
below. The higher the quality selected, the smoother the curves on the text will be drawn
more memory will be required to display the text and it will be slower to display.

Leave the Invert Text check box unchecked to display your text as 3D letters. Click OK. 
text will be placed in the document window:

Check the Invert Text check box and click OK. The text will be ‘punched out’ of a solid recta
G-3
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The text can be moved, resized and rotated, have colors, textures, images and sounds a
it and the geometry path can be edited. You will not be able to ungroup a word to edit in
ual characters, although you can ungroup the front and back faces and extruded outlines
this you must flag the text as Dismantleable. See Dismantleable on page 3-35 and Primitive/
Dismantleable on page 4-18 for further details. If you need to manipulate individual charac-
ters, they must be entered separately.

υ Animation Draw Path

The Animation Draw Path plug-in is used to draw animation path geometries.

Select the Animation Draw Path tool, position the cursor where you want to begin drawin
click the mouse button to place a vertex point, move the cursor to a new point and click 
To finish the line, double click.
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To draw an arc, hold down the Option key and click at the point that will represent the cen
a circle. Release the Option key and mouse button and move the cursor ready to place t
point. The arc will display. Click to place the next point at the end of the arc:

To draw a Bezier curve, click and drag the cursor:

To draw a spline curve, hold down the Option key and click and drag the cursor:

• To delete the last point placed use the Delete key. 

• To complete an Animation Path double click.

• To constrain the path to the X, Y, or Z axis hold down the Shift key. 

• To move in the Z dimension, hold down the Control key.
G-5
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To change the default settings for eye level height and locking for the Animation Draw P
plug-in:

1. Hold down the Option key and select the Animation Draw Path tool to display the 
mation Draw Path Options.

2. Select the Lock to eye level checkbox to control if an Animation Path geometry wi
locked to the X-Z dimension at the value of eye level height.

3. Enter a value in the Eye level height field(s) to specify the position in Y coordinate
which the Animation Path geometries will be drawn.

υ Cone

The Cone plug-in is used to draw cone geometries.

Place the cursor at the point you want to begin drawing, hold down the mouse button an
to create a cone:
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Hold down the Control key and move the mouse up or down to change the depth of the 

Holding down the Shift key to constrain the cross section of the cone to a circle, and the 
of the cone to the diameter of the base:

In 2D mode, you will not be able to create a 3D object and holding down the Shift key w
constrain the object shape to a triangle with equal sides, or a circle, depending upon wh
plane you are drawing in. Using the Control key in 2D mode will not add depth to an obj
but you can use it to draw your 2D shape in the Z dimension.
G-7
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υ  Cube

The Cube plug-in is used to draw cube geometries.

Select the Cube plug-in from the Tools palette. Position the cursor at the point you want
begin drawing and, holding down the mouse button, drag to create the cube geometry: 

Hold down the Control key and move the cursor up or down to change the depth of the c
G-8
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Hold down the Shift key while drawing to constrain the geometry to a cube:

In 2D mode you will not be able to create a 3D object, and holding down the Shift key w
constrain the object shape to a square. Using the Control key in 2D mode will not add de
an object, but you can use it to draw your 2D shape in the Z dimension.

υ Cylinder

The Cylinder plug-in is used to draw cylinder geometries.

Select the Cylinder plug-in from the Tools palette. Place the cursor at the point you wan
begin drawing and, holding down the mouse button, drag to create the cylinder geometr
G-9
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Hold down the Control key and move the mouse up or down to change the depth of the c
der:

Hold down the Shift key while drawing the object to constrain the cross section of the cyl
to a circle, and the length of the cylinder to the diameter of the circle:

In 2D mode, you will not be able to create a 3D object, and holding down the Shift key w
constrain the object shape to a square or circle depending on the plane you are drawing
Using the Control key in 2D mode will not add depth to an object, but you can use it to d
your 2D shape in the Z dimension.
G-10
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υ Irregular Polygon

The Irregular Polygon plug-in is used to define a cross section, which is then extruded to
an irregular polygon geometry.

1. Position the cursor where you want to begin drawing, click the mouse button to pl
vertex point, move the cursor and click again:

2. To draw an arc, hold down the Option key and click at the point that will represent
center of a circle.
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3. Release the Option key and mouse button and move the cursor ready to place th
point. The arc will display:

4. Click to place the next point at the end of the arc.

5. To draw a Bezier curve, click and drag the cursor.

6. To draw a spline curve, hold down the Option key and click and drag the cursor.

7. Use the Delete key at any time to delete the last point placed.
G-12
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8. Double-click at any time to complete the shape.

The following modifier keys can be used when drawing the irregular polygon cross secti

• The Control key: Use the Control key to adjust the position of the cursor in the third dim
sion when placing the first three points. This will define the plane in which the polygo
drawn.

• The Shift key: Hold down the Shift key to constrain lines to the two axes of the plane i
which you are drawing. Constraining lines will display.

• The Command key: Hold down the Command key to draw a line tangent or perpendicu
to the previous line or curve. Constraining lines will display.

υ Lathe

The Lathe plug-in is used to define a lathe template and produce a lathed geometry from

Drawing a Lathe Template

1. Select the Lathe plug-in from the Tools palette.
G-13
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2. Determine the lathe axis by clicking once, moving the cursor, and clicking a secon
time. Note: The lathe axis is constrained to either the X, Y or Z axis. A yellow line 
resenting the axis your object will be lathed around displays:

3. Position the cursor at the point to start drawing the lathe template. Click the mous
ton to place a vertex point, move the cursor the desired distance and click again:
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4. To draw an arc, hold down the Option key and click on the point that will represen
center of a circle:

5. Release the Option key and the mouse button and move the cursor ready to plac
next point. The arc will appear:

6. Click to place the next point at the end of the arc.
G-15



7. To draw a Bezier curve, click and drag the cursor:

8. To draw a spline curve, hold down the Option key and click and drag the cursor:
G-16



e 

s line 
9. Double-click to lathe a geometry from the template:

At any time while drawing the lathe template:

• Hold down the Shift key to constrain lines to one of the two axes of the plane you ar
drawing in. 

• Hold down the Command key to draw a line tangent or perpendicular to the previou
or curve. Constraining lines will display.

• Use the Delete key to delete the last point placed.

υ Pipes

The Pipes plug-in is used to draw pipe geometries.
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1. Hold down the Option key and select the Pipes tool from the Tools palette to displa
Pipe Tool Options dialog:

2. Enter a value in the Pipe Diameter field to specify the width of the pipe.

• Enter zero: A polyline will be drawn. This will be drawn as one pixel thick, regardle
of the view.

3. Enter a value in the Outer Bend Radius field to specify how the bends in the pipe s
be drawn.

• Enter zero: Mitred joints will be generated.

• Enter half the pipe's diameter: The outer half of the joint will be rounded with the radiu
value and the inner half mitred — just like a pipe elbow.

• Enter a value more than the pipe's diameter: Gradual bends will be generated (if there 
not enough straight pipe on each side of the bend to generate gradual bends, the
of the curve will be reduced).

4. Enter a value in the Sides to a 360° Bend field to determine the accuracy with wh
bends in the pipe are formed. (The Edges to a circle preference controls the num
vertices used to form each cross section of pipe. See Preferences on page 3-5 for furthe
details.)

5. Check the End caps checkbox if you wish the pipe to be sealed at both ends.

6. Click OK, the options will remain as set until changed.
G-18
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7. With the Pipes tool still selected, position the cursor where you want to begin draw
click the mouse button to place a vertex point, move the cursor and click again:

8. To draw an arc, hold down the Option key and click at the point that will represent
center of a circle:
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9. Release the Option key and mouse button and move the cursor ready to place th
point. The arc will display:

10. Click to place the next point at the end of the arc.

11. To draw a Bezier curve, click and drag the cursor:
G-20
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12. To draw a spline curve, hold down the Option key and click and drag the cursor:

13. Use the Delete key at any time to delete the last point placed.

14. Double-click at any time to complete the shape:

Hold down the Shift key while drawing the pipe path to constrain the path to the X, Y, or 
axis. To move in the Z dimension, hold down the Control key.
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υ Point Light

Use the Point Light plug-in to place point lights in your Modeler document. Point lights rad
light in all directions.

Note: Light objects are visible by default. If you have turned off the Show Light Markers 
option in the Lights palette, the light objects will not be displayed. See Lights on page D-20 for
more details.

Select the Point Light tool in the Tools palette and click in the document window. The lig
placed at the point clicked.

A point light is displayed as a small cube and when selected has a bounding sphere. Po
lights cannot be resized, but can be moved and rotated like other objects. Note that rota
point light will not have any affect on the lighting in the document.

Hold down the Command key when placing a point light and, if the scene is rendered us
Microspot renderer that draws shadows, that particular light will not cast any shadows.

Hold down the Option key when placing a point light and a light with a negative brightne
value will be placed in the document. The negative brightness value can be adjusted us
Brightness slider in the Info palette as usual. To adjust a light with a negative brightness
so that it has a positive brightness value, set the brightness to 0 in the Info palette, then
brightness as for an ordinary point light.

The Info Palette is used to specify the color and brightness of a selected point light. See Info 
Palette on page 4-17 for further details.

The color of the point light sphere is set in the Preferences dialog. If the color chosen is
(default) light markers take on the color of light they represent. See Preferences on page 3-5 
for further details. 
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υ  Pyramid

The Pyramid plug-in is used to draw pyramid geometries with a specified number of side

1. Hold down the Option key and select the Pyramid plug-in from the Tools palette to
play the Pyramid Options dialog:

2. Enter a value in the Number of sides field to specify the number of sides the pyra
should have.

3. Place the cursor at the point to begin drawing, hold down the mouse button and d
create the pyramid geometry:
G-23



of the 

mid 
 diam-

ill 
n 
an 

f 
4. Hold down the Control key and move the mouse up or down to change the depth 
pyramid. Release the mouse button when the pyramid reaches the desired size:

5. Hold down the Shift key while drawing the object to constrain the base of the pyra
so that each side is the same length, and constrain the height of the pyramid to the
eter of an imaginary circle that touches all the points of the base:

In 2D mode, you will not be able to create a 3D object, and holding down the Shift key w
constrain the object shape to a polygon with equal sides, or to a triangle, depending upo
which plane you are drawing in. Using the Control key in 2D mode will not add depth to 
object, but you can use it to draw your 2D shape in the Z dimension.

υ Regular Polygon

The Regular Polygon plug-in is used to draw regular polygons with a specified number o
sides.
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1. Hold down the Option key and select the Regular Polygon plug-in in the Tools pal
to display the Regular Polygon Options dialog:

2. Enter a value in the Number of sides field to specify the number of sides the regu
polygon should have. The number of sides will remain as specified until you chan

3. Place the cursor at the point to begin drawing, hold down the mouse button and d
create the regular polygon:

4. Hold down the Control key and move the mouse up or down to change the depth 
regular polygon. Release the mouse button when the polygon reaches the desire
G-25
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5. Hold down the Shift key while drawing the object to constrain the cross section of
polygon so each side is the same length, and constrain the height of the shape to
diameter of an imaginary circle that touches each point of the base of the polygon

In 2D mode, you will not be able to create a 3D object and holding down the Shift key w
constrain the object shape to a polygon with equal sides, or a square, depending upon w
plane you are drawing in. Using the Control key in 2D mode will not add depth to an obj
but you can use it to draw your 2D shape in the Z dimension.
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υ Sphere

Use the Sphere plug-in to draw ellipses and spheres.

1. Place the cursor at the point you want to begin drawing, hold down the mouse bu
and drag to create an object:

2. Hold down the Control key and move the mouse up or down to change the object
depth. Release the mouse button when the ellipse/sphere reaches the desired siz

3. To constrain the shape of the object to a sphere, hold down the Shift key while dra
G-27
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In 2D mode, you will not be able to create a 3D object, and holding down the Shift key w
constrain the object shape to a circle. Using the Control key in 2D mode will not add dep
an object, but you can use it to draw your 2D shape in the Z dimension. See Primitive/Disman-
tleable on page 4-18 for further details.

υ Spot Light

Use the Spot Light plug-in to place spot lights in your Modeler document. Spot lights ha
directional shade around them which can be rotated to direct light in a specific direction.

Note: Light objects are visible by default. If you have turned off the Show Lights option in
Lights palette, the light objects will not be displayed. See Lights on page D-20 for more 
details.

Select the Spot Light tool in the Tools palette.

• To place a spot light at a specific position in the document: move the cursor to that point, click
and release the mouse button.

• To direct the light as you place it in the document: click on the point you wish the spot light
to shine and drag the light into position before releasing the mouse button. Hold dow
Shift key when dragging the light to constrain it to an axis perpendicular to the surfa
clicked on.
G-28
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A spot light is displayed as an open, four sided pyramid with a line coming out of it. The
indicates the direction the light is pointing. When a light is selected it displays with a boun
sphere. Spot lights cannot be resized, but can be moved and rotated like other objects.

Hold down the Command key when placing a spot light and, if the scene is rendered us
Microspot renderer that draws shadows, that particular light will not cast any shadows.

Hold down the Option key when placing a spot light and a light with a negative brightnes
value will be placed in the document. The negative brightness value can be adjusted us
Brightness slider in the Info palette as usual. To adjust a light with a negative brightness
so that it has a positive brightness value, set the brightness to 0 in the Info palette, then
brightness as for an ordinary point light.

The Info Palette is used to specify the color, brightness, spread and sharpness of a selec
light. The Spread control adjusts the lens angle, while the Sharpness control adjusts the
See Info Palette on page 4-17 for further details.

The color of the spot light pyramid is set in the Preferences dialog. If the color chosen is
(default) light markers take on the color of light they represent. See Preferences on page 3-5 
for further details. 

υ Torus

Use the Torus plug-in to draw a torus geometry which is a shape like a doughnut.

Select the Torus tool from the Tools palette. Click on the grid and drag out a torus shape
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The torus is drawn with reference to the preference value, Edges to a Circle. See Preferences 
on page 3-5 for further details.

To change the Torus options, hold down the Option key and select the Torus tool from th
Tools palette again. The Torus Tool Options dialog displays:

Enter a value in the Ring To Hole Ratio field to specify how thick the outer ring of the tor
should be in relation to the diameter of the central hole.

• The default value of 1 will produce a torus where the thickness of the outer ring is th
same as the diameter of the central hole.

• A value less than 1 will produce a torus where the thickness of the outer ring is the l
than the diameter of the central hole.

• A value greater than 1 will produce a torus where the thickness of the outer ring is th
more than the diameter of the central hole.
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Appendix H

Plug-in Modifiers

Plug-in Modifiers are plug-in tools that are used to modify objects or the
scene in some way. When installed they are located in the Tools palette.
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υ Introduction

 When loaded, plug-in modifiers appear in the Tools palette as shown below. 

υ Animation Edit Path

The Animation Edit Path plug-in is used to edit the path of an animation path and can al
used to scale and rotate sections of an Animation Path at specific points on its path.
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VR
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Gravity

Shear

Orbit

Walkthrough View Finder

Animation Edit Path

Scale Object

Attribute

Construct
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The  Animation Edit Path Dialog

To display the Animation Edit Path dialog, click on the Animation Edit Path tool in the To
palette. 

Selecting an Animation Path to edit

With the Animation Edit Path tool selected, click on an animation path in the document w
dow. The selected path will display as a black line with handles at the ends and on the c

Types Of Point

• Vertex: A standard point used to define the beginning or end of a straight section of a
or line.

• Arc: A point on a section of a circle defined as the center point on the arc between tw
tex points.
H-3
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• Spline: A point on a curve. The curve is defined automatically and cannot be edited e
by adjusting the points at either side of the spline point.

• Bezier: A point on a curve. Two Bezier handles allow the curve to be adjusted.

Vertex point handles display as squares, Bezier and spline point handles as diamonds, 
point handles as spheres.

Viewing Manipulations

The Position, Scale or Twist radio buttons allow you to determine how the path will be m
ulated when selected with the Animation Edit Path tool.

• Position: If this option is chosen, path points manipulated.

• Scale: If this option is chosen, the amount of scale per point is manipulated.
H-4
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• Twist: If this option is chosen, the amount of twist per point is manipulated.

Selecting Points

Click on a handle to select it.

• A Vertex, Arc or Spline point will change color.

• A Bezier point will change color but has two additional handles to adjust the Bezier c

To select additional points, hold down the Shift key and click on another point. To desele
points, hold down the Shift key and click on a selected point.

Manipulating Points

• Vertex,  Arc, Spline: Click and drag on the point to move it. Adjust the scale or twist of t
section at that point by selecting the scale or twist radio button on the Animation Edit
dialog.

• Bezier: Click and drag on the point to move it. Adjust the scale or twist of the section 
that point by selecting the scale or twist radio button on the Animation Edit path dial
Click and drag on the Bezier handles to adjust the curve. Hold down the Option key
click and drag on the Bezier point or Bezier handles to break the Bezier curve.

Moving Points On The Path

To move a path handle of any type, click on it and drag.

• Select the Position radio button in the Animation Edit Path dialog.

• Click on the handle of the point on the animation path you wish to move.

• Drag the path handle to the new position.

• Use the Control key to change the axis used.
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To move a point by precise values, click on the Relative to Path or Relative to World radi
ton in the Edit Path dialog and enter values in the x, y and z fields.

• Relative to Path: The selected point is moved to the values entered relative to the poin
the start of the path.

• Relative to World: The selected point is moved to the values entered relative to the gri

Adding Points To A Path

To add a point to a path, select two contiguous points on the path by clicking on the line
between them, or by holding down the Shift key and clicking on a second point. Click on
Vertex, Arc, Spline or Bezier button in the Animation Edit Path dialog. A point of the spec
type will be added between the two points originally selected.

Alternatively, hold down the Option key, click on the path or an existing handle and drag
place a new Vertex point.

Note: An arc point can only be added between two vertex points.

Changing Points

To change a point to a different type, select the point then click on the Vertex, Arc, Spline
Bezier button in the Animation Edit Path dialog. The point will change to the type selecte

Note: An arc point can only be added between two vertex points.

υ Attribute

The Attribute plug-in is used to change an object’s transparency, surface color, reflective
gloss and renderer brightness, simply by clicking on the object. Random values or value
ied from another object can be applied.

• To apply random values to an objects: Select the Attribute tool from the 
Tool palette. Hold down the Shift key and move the cursor over an object in 
the document window, the cursor will change to a die. Click on the object 
to apply random values.
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• To apply the same random values to another objects: Click on the 
Attribute tool again. Move the cursor over an objects and it will change to a 
paint bucket. Click on the object.

• To copy an object’s values: Click on the Attribute tool and hold down the 
Option key. The cursor will change to an eye dropper. Click on an item to 
copy its values.

• To apply copied values: Click on the Attribute tool again and the cursor 
will change to a paint bucket. Click on the object to which you want to 
apply the copies.

υ Construct

The Construct plug-in is also available as a plug-in modifier tool. See Construct on page D-17
for more details.

To use the Construct tool in the Tool palette:

1. Select the Construct tool from the Tool palette:

2. In the document window, select the object to perform the Boolean operation on (o
A).

3. Depending on the Boolean option radio button currently selected in the Construct
ette, the cursor will display as one of the following:

• A plus sign for A add B.

• A minus sign for A minus B.

• A division sign for A split B.

• An ampersand (&) for A intersect B.

4. Click on the object you want to perform the operation with (object B). The Boolea
operation will be applied permanently to the two objects.

To change the options set in the Construct palette, hold down the Option key and click o
Construct tool in the Tool palette. The Construct palette will open.
H-7



t win-
n an 

 Info 
vity 

int 
e of 
 pre-

n.

docu-
 

 on a 
d 
υ Gravity

The Gravity plug-in is used to place objects on the grid.

Select the Gravity tool from the Tools palette. As the cursor is moved over the documen
dow it will change to a downward arrow. The active point is at the tip of the arrow. Click o
object and it will be moved so that its lowest point is placed on the grid.

If an object has been locked by clicking on the padlock icon in the top right corner of the
palette, or by selecting Lock from the Options menu, you will not be able to use the Gra
tool to drop the object to the grid. 

If the object position is locked only in the Y-axis, the Gravity tool will over-ride this restra
and can be used to drop the object to the grid. If you have several objects selected, som
which may be locked in the Y-axis, hold down the Shift key when using the Gravity tool to
vent these locked objects from being dropped to the grid.

υ Light Director

The Light Director plug-in is used to direct one or more spot lights in a particular directio

Select the light(s) to direct, then select the Light Director tool in the Tools palette. In the 
ment window, click at the place you want the lights to point. The light(s) will be rotated to
point at the place specified.

Lights can also be selected using the Light Director tool by selecting the tool and clicking
light. Hold down the Shift key and click on additional lights to increase the selection. Hol
down the Shift key and click on a selected light to remove it from the selection.
H-8
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υ Orbit

The orbit plug-in is used to move the camera around a selected object.

Select the Orbit tool from the Tool palette. Move the cursor over the document window a
will change to a black diamond.

• Click on an object: drag the mouse left, right, up, or down and the view will orbit aroun
the center of the object’s bounding frame.

• Click on the grid: drag the mouse left, right, up, or down, and the view will orbit around 
center of the grid.

• Click in an empty area of the document window: drag the mouse left, right, up, or down, an
the camera will orbit around the center of the grid.

In all cases, the further you move the mouse from the point where you first clicked, the f
the view will move. Use of the option key will slow this rate of movement.

υ Scale Object

The Scale plug-in is used to easily scale selected objects by percentage values.

1. Select the Scale Object tool from the Tool palette. The Scale Object dialog displa
H-9
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2. To maintain an object’s proportions, ensure that the ALL checkbox remains checke

3. To scale an object without maintaining its proportions, uncheck the All checkbox. E
a value in percentage to scale the object in each of the x, y and z dimensions.

4. Click OK, and the object selected will be scaled by the specified value(s).

υ Shear

The Shear plug-in is used to distort shapes.

Select the Shear tool from the Tool palette then select an object in the document window
object’s normal bounding frame and handles will not display, instead the object will displ
a bounding frame with handles in the center of each surface.

Click on a handle and drag to shear the object. When you move the handle, the surface
bounding frame opposite the handle you are moving will remain stationary, but the other
faces of the bounding box will move as you drag the handle. The object will be distorted
continue to fit in the bounding frame.

To move a handle in the Z dimension, hold down the control key as you drag. To constra
movement of the handle to the X, Y, or Z axis, hold down the shift key as you drag.
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υ Sun Direction

The Sun Direction plug-in is used to adjust the direction the sun light shines in.

The Sun Direction plug-in has the following options, displayed by selecting the Sun Dire
plug-in with the Option key pressed.

The Option dialog box allows you to enter values for both the angle of elevation of the sun
its position angle referenced from the clockwise direction, relative to the north.

When the Sun Direction plug-in is selected, and the Auto Show Plug-in Palettes prefere
enabled, the Lights palette is automatically opened so that you can make any necessary
changes to the way the scene is lit. See Lights on page D-29 for more details.

To adjust the position of the sun manually

1. Select the Sun Direction tool from the Tools palette.

2. The document window changes to Top view.
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3.  The current direction the sunlight is shining in is depicted as a red line with a han
the end:

4. Click on the handle and holding down the mouse button drag to change the positi
the source of the sun light.

5. Hold down the Control key as you drag to move the position of the source of the s
light closer or further away.

6. Movement of the sun direction line can be constrained to the X, Y and Z axes by h
ing down the Shift key.

7. Release the mouse button to drop the handle at its new location.

Note: The red direction line will not be visible with either the Microspot Preview Renderer
the Microspot Renderer.
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υ View Finder

The View Finder tool allows you to click anywhere in the document to change the camer
entation to have that point at the center of the view.

υ VR

The VR plug-in is used to pan and tilt the camera using control mechanisms similar to th
found in QuickTime™ VR.

When the VR plug-in is selected, the NaviCam palette is automatically opened so that yo
use it to make changes to the camera position and view. See NaviCam on page D-30 for more
details.

Select the VR tool from the Tools palette and click in your document window.

• To pan the camera (turn it left and right): hold down the mouse button and drag the m
left and right.

• To tilt the camera: hold down the mouse button and drag the mouse up and down. T
is limited to +/- 90°.

• To crab the camera (move it to the left or right): hold down the mouse button and the
mand key and drag the mouse left and right.

• To move the camera forwards and backwards: hold down the mouse button and the
mand key and drag the mouse up and down.

• To zoom in: hold down the Shift key.

• To zoom out: hold down the Control key.

As you move, the cursor changes to an arrow head pointing in the direction you are mov
all cases, the further you move the mouse from the point first clicked on, the faster the c
will move. Use of the option key will slow this rate of movement.

Alternatively, select the VR tool and use the arrow keys to move the camera:
H-13



e the 

e the 

w 
ove in 
 right 
ra.

 mov-
r the 
• To pan the camera (turn it left and right): use the left and right arrow keys.

• To tilt the camera: use the up and down arrow keys. The tilt is limited to +/- 90°.

• To crab the camera (move it to the left or right): hold down the Command key and us
left and right arrow keys.

• To move the camera forwards and backwards: hold down the Command key and us
up and down arrow keys.

υ Walkthrough

The Walkthrough plug-in is used to walk the camera through a scene.

Select the Walkthrough tool from the Tool palette. Click in your Modeler document windo
and the cursor will change to a black diamond. Drag the mouse to the left and right to m
those directions, or up to move forwards and down to move backwards. Use the left and
arrow keys to crab (move side to side), and the up and down arrow keys to tilt the came

As you move, the cursor changes to a black arrow head pointing in the direction you are
ing. In all cases, the further you move the mouse from the point first clicked on, the faste
camera will move.

Use of the option key will slow the rate of movement.
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Appendix I

Microspot Plug-in Renderers
Table of Contents

Introduction I-2

Selecting Microspot Renderers I-2

Renderer Options I-3
Renderer Options Dialog I-3
Shadows I-3

On/Off I-3
Resolution I-3
Soft Edges I-3

Anti-alias Image I-4
Anti-alias Image is Off I-4
Anti-alias Image is On I-4
I-1

Return to main table of contents



Inter-
ing. 
r the 

s sur-

d Soft 

Options 
 

υ Introduction

The Microspot Renderer provides the following features in addition to those provided by 
active renderer: transparency; shadows; pixel level lighting calculations; image anti-alias
These features allow you to render a high quality, more realistic 3D scene — in particula
pixel level lighting calculations give more accurate representations of how lighting affect
faces.

The Microspot Preview Renderer is a limited version of the Microspot Renderer. The 
Microspot Preview Renderer allows a fast display of a scene rendered with Shadows an
edges. 

υ Selecting Microspot Renderers

The Microspot Renderer is accessed via the Renderer Options palette. Select Renderer 
from the Palettes menu to display this palette. Click on the Renderers pop-up menu, the
Microspot Renderer and the Microspot Preview Renderer. 
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υ Renderer Options

To change the Microspot Renderer options in Modeler select the Options button in the u
right corner of the palette or hold down the Option key when selecting the Microspot Ren

Renderer Options Dialog

The dialog provides controls to turn shadows on or off, adjust the resolution of the shado
soften the edges of the shadows and choose how much an image is anti-aliased. Click O
when you have set the rendering options you want to render the scene.

Shadows

On/Off

The Microspot Renderer and the Microspot Preview Renderer both create realistic shad
The Microspot Render has the option of not creating shadows when rendering.

Resolution

Increasing the sharpness of the shadows that are created 

Soft Edges

Turning on soft edges will soften the edges of the shadows, creating a more realistic sha
effect.
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Anti-alias Image

Use the anti-alias image checkbox to turn anti-aliasing on or off for the image. If image a
aliasing is turned off, the whole image is rendered at the same resolution. If image anti-a
is turned on, the edges of objects in the image are softened. Select the quality of render
Good, Better and Best radio buttons.

Anti-alias Image is Off

• Good: The image will be rendered at 72 dpi. A typical 640 x 480 render will require 2
Mb of RAM as an image buffer.

• Better: The image will be rendered at 144 dpi. A typical 640 x 480 render will require 
Mb of RAM as an image buffer.

• Best: The image will be rendered at 288 dpi. A typical 640 x 480 render will require 40
of RAM as an image buffer.

Anti-alias Image is On

• Good: The image will be rendered at 72 dpi, with soft edges at 288 dpi. A typical 640
480 render will require 2.5 Mb of RAM as an image buffer.

• Better: The image will be rendered at 72 dpi, with soft edges at 1152 dpi. A typical 64
480 render will require 2.5 Mb of RAM as an image buffer.

• Best: The image will be rendered at 144 dpi, with soft edges at 1152 dpi. A typical 64
480 render will require 10 Mb of RAM as an image buffer.
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Appendix J

Drag and Drop

This section discusses dragging and dropping colors, 3D objects, text, TIFF,
JPEG, GIF and Movie files to and from  Modeler documents.
Table of Contents

Drag Output J-2

Copy J-3

Drag Input J-3

Notes J-4
J-1

Return to main table of contents
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DRAG OUTPUT

You can drag a color from the Window control panel, Lights Palette or Info Palette to:

• A 3D object in  Modeler

• Another Lights Palette or Info Palette color or any other palette that includes color bu

• The Finder Desktop or a Folder window

• The Finder Trash Can

• An Modeler Library file

• A PICT-compatible, Drag & Drop aware application

You can drag a 3D object or an entire scene (by holding down the Option key and clickin
the background) to:

• Another view of the same file in  Modeler

• The window of a different file in Modeler

• A 3DMF-compatible, Drag & Drop aware application

• A PICT-compatible, Drag & Drop aware application

• The Finder Desktop or a Folder window

• The Finder Trash Can (to delete the object)

• A Modeler Library file
J-2
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COPY

When you copy selected items from a  an Modeler document, the following types of data
put on the Clipboard:

• A PICT of the selected items which is the same size as the front window

• A 3DMF as a single grouped item.

DRAG INPUT

Drag a PICT file from the Finder to:

• A 3D object to create a texture of the picture wrapped around the object

• The document window to make a background picture

• The document window to make a foreground picture (hold down the Control key whe
dropping the file)

• The grid to make a rectangle with a texture of the picture

Drag a text file from the Finder to:

• A 3D object to create a texture of the text wrapped around the object

• The background to make a background picture of the text

Drag a TIFF, JPEG GIF or Movie file from the Finder to:

• A 3D object to create a texture of the picture wrapped around the object.

Drag a 3DMF file from the Finder to:

• A  Modeler document (to import it)
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Drag a clippings file of the following type from the Finder:

• A PICT clipping (See Drag a PICT file from the Finder)

• 3DMF clipping (See Drag a 3DMF file from the Finder)

Drag  an Modeler color clipping file (created by dragging a color from a color button into
Finder) from the Finder to:

• A 3D object to change its color

• The background to change its color

• The Default Color button, to change the default color, as well as any selected items

• The Lights Palette to change the color of the appropriate light

• The Info Palette to change the color of the selected object/light

• Any other palette that includes color button.

NOTES

• To drag and drop locked items out of an Modeler document window, hold down the 
Option key.

• Holding down the Control key as you drag and drop an item onto an object or group
ungroups the object or group and places the item on just one surface of the object, 
one item in the group.

• Hold down the Option key as you drag a 3D object to leave a duplicate in the same 
as the original.
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Appendix K

Plug-in Directory

Lists the application’s plug-ins by name, provides details of the plug-in’s
type and status, and offers a brief description of its use.
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Appendix L

Command Key Table

Command key shortcuts can be used to perform many actions. The following
table lists those key combinations.
Table of Contents

Command Key Table L-2
File Menu L-2
Edit Menu L-2
View Menu L-2
Options Menu L-3
Plug-in Menu L-3
Help Menu L-3
L-1
Return to main table of contents



COMMAND KEY TABLE

Action Command Key

File Menu

New Command N

Open Command O

Close Command W

Save Command S

Print Command P

Quit Command Q

Edit Menu

Undo/Redo Command Z / F1

Cut Command X / F2

Copy Command C / F3

Paste Command V / F4

Delete Whole Object Backspace / Delete

Select All Command A

Duplicate Command D

Duplicate No Offset Command Shift D

Clone Command =

Clone No Offset Command Shift =

Group Command G

Ungroup Command U

View Menu

New Window Command K

Look At Selected Command 1
L-2



Home View Command 3 / Home

Custom (View) Command 0

Top (View) Command 5

Front (View) Command 8

Left (View) Command 4

Right (View) Command 6

Back (View) Command 2

Plan (View) Command 7

Last View Command 9 / End

Options Menu

Edit Item Command E

Lock Command L

Unlock Command Shift L

Grid Snap Command Y

Metric Command M

Inches Command I

Orbit Around View Command T

Plug-in Menu

Last Plug-in Command *

Help Menu

Online Manual Help

Action Command Key
L-3


	Microspot Modeler USER GUIDE
	Contents
	Introduction
	Introduction
	Entering serial number
	Welcome screen
	Technical Support

	Tutorial
	Tutorial One
	Introduction
	Getting Started
	The Grid
	View
	Drawing The Legs
	Drawing The Seat
	Drawing The Backrest
	Saving The Model
	Positioning The Spot Lights
	Setting The Sun Direction
	Base Plate
	Final Render

	Tutorial Two
	Getting Ready
	Drawing The Cushion Seat
	Changing The Back Legs
	Changing The Back Rest

	Tutorial Three
	Altering The Back Legs
	Changing The Back Rest
	Drawing The Chair Supports

	Tutorial Four
	The Final Seat
	The Final Legs
	The Final Supports
	The Final Backrest

	Windows And Doors Tutorial
	Animation Tutorial
	Introduction
	Creating the Scenery
	Animation Palettes
	Animating Objects
	Animating Lights
	Animating Camera
	Exporting a Movie
	Summary


	Menus
	Modeler Menu
	About Modeler
	About Plug-ins
	Preferences
	Quit

	File Menu
	New
	Open
	Insert
	Import
	Export
	Close
	Save
	Save As
	Revert
	Page Setup
	Print

	Edit Menu
	Undo
	Cut
	Copy
	Paste
	Paste Special
	Delete
	Select All
	Select None
	Duplicate and Clone
	Group
	Ungroup

	View Menu
	New Window
	Close Window
	Name View
	Delete View
	Change View
	Open Documents

	Options Menu
	Edit Group
	Lock
	Unlock
	Primitive
	Dismantleable
	Grid Snap
	Grid Options
	Metric
	Inches
	Window Size
	Orbit Around View

	Palettes Menu
	Plug-in Menu
	Animation Menu
	Help Menu
	Modeler Manual
	Microspot Library Download
	Registration Information
	Upgrade Information


	Palettes
	Introduction
	Tools Palette
	Select/Move
	Select/Move/Scale
	Select/Move/Rotate
	Manipulating The Grid
	Rectangular Marquee
	Hand

	Info Palette
	Name
	Primitive/Dismantleable
	Lock
	Position
	Size
	Rotation
	Transparency/Brightness
	Color
	Comments

	The Help Palette
	Window Controls
	Zoom Out
	Zoom In
	Wire Frame
	Solid Fill
	Orthographic
	Perspective
	Coordinate Systems
	Radius
	Diameter
	2D
	3D
	View
	Default Color
	Window Resize


	Import Plug-ins
	Introduction
	3ds

	Export Plug-ins
	Introduction
	Picture

	Menu Command Plug-ins
	Introduction
	Auto Save
	Base Plate
	Construct Idler
	Counter
	Gravity
	Export Movie
	Light Start
	Light Stop
	Object Color Start
	Object Color Stop
	Object Texture Start
	Object Texture Stop

	Plug-in Palettes
	Introduction
	Align
	Animation Path
	Animaton Player
	Animation Tweener
	Axis
	Color
	Color Palette
	Construct
	Cursor Options
	Item Tag
	Libraries
	Lights
	NaviCam
	Nudge
	Renderer Options
	Section
	Textures
	Tripod

	Idler Plug-ins
	Table of Contents
	Construct Idler


	Plug-in Tools
	Introduction
	Configuring The Tools Palette
	Tool Options

	Plug-in Geometries
	Introduction
	3D Text
	Animation Draw Path
	Cone
	Cube
	Cylinder
	Irregular Polygon
	Lathe
	Pipes
	Point Light
	Pyramid
	Regular Polygon
	Sphere
	Spot Light
	Torus

	Plug-in Modifiers
	Introduction
	Animation Edit Path
	Attribute
	Construct
	Gravity
	Light Director
	Orbit
	Scale Object
	Shear
	Sun Direction
	View Finder
	VR
	Walkthrough

	Microspot Plug-in Renderers
	Introduction
	Selecting Microspot Renderers
	Renderer Options

	Drag and Drop
	Drag Output
	Copy
	Drag Input
	Notes

	Plug-in Directory
	Command Key Table
	Command Key Table



